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1. Introduction 

1.1 Purpose and Scope. 
 
The purpose of this document is to present to the worldwide scientific community what tools are available 
for viewing, downloading, processing, calibrating and plotting THEMIS data and how to use these tools.  

1.2 Applicable Documents. 
1. THM_SYS_012_PDMP    THEMIS Project Data Management Plan 
2. THM_SOC_101_TIME    THEMIS TIME Definition 
3. THM_SOC_103_HKP_VARNAMES  THEMIS Housekeeping L1 Variable Name Def's  
4. THM_SOC_105_FIELDS_VARNAMES  THEMIS Fields Variable Names Definitions 
5. THM_SOC_108_GMAG_L1_VARNAMES  THEMIS GMAG Variable Name Definitions 
6. THM_SOC_110_COORDINATES   THEMIS Coordinate Systems Definitions 
7. THM_SOC_111_SUNSENSPROC   THEMIS SUN SENSOR Science Processing 
8. THM_SOC_112_ATTPAIPROC   THEMIS Science ATT & Inertia Determ. 
9. THM_SOC_113_FGM_CALPROC  THEMIS FGM CAL File and Processing 
10. THM_SOC_114_SCM_CALPROC   THEMIS SCM CAL File and Processing 
11. THM_SOC_115_EFI_CALPROC   THEMIS EFI CAL File and Processing 
12. THM_SOC_116_ESA_CALPROC   THEMIS ESA CAL File and Processing 
13. THM_SOC_117_SST_CALPROC   THEMIS SST CAL File and Processing 
14. SAI-SPEC_1079A (Oct. 26, 2005)   THEMIS Coordinate Systems 
15. SAI-RPR-0722a (September, 2006)   Probe Alignment Report (MSSS data, p18) 
16. pturin e-mail on Faro alignment results (9/28/06) FGM, SCM mag alignments 
17. THM-MB-005-Magnetometer clocking r7.pdf MAG clocking angles 
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2. THEMIS Web Page Interface 

2.1 THEMIS Web Site - Home Page 
 
The THEMIS Home Web Page can be displayed by using the following URL: http://themis.ssl.berkeley.edu/. 
Across the top portion of this web page are a series of drop down menus (Home, The Mission, Data, Software, Publications, 
News & Events, Contact Us and For the Public). In this document we will be discussing only the Data, Software and Contact 
Us Web Pages.  
 
The THEMIS Data Drop Down Menu allows you to select the following options:  Overview, Usage Rules, Summary Plots, 
Data Retrieval, Data Descriptions, Event List and Data Processing Status. These options will be discussed in more detail in 
Section 2.2. 
 
The THEMIS Software Drop Down Menu allows you to Select the following options: Software, Developers and  
Documentation. These options will be discussed in more detail in Section 2.3. 
 
The THEMIS Contact Us will automatically link you to a web page that will allow you to send 
emails to the THEMIS PI or THEMIS Instrument Scientists or send a Help Request to the THEMIS Science Support Team 
with Comments, Observations, Problems or Questions concerning data, a document, download, GUI, Plot, Software, Web 
Interface or any other issue not listed.  
This Help Request option will be discussed in more detail in Section 2.4.  
 
Please note: Differences between the screen displays presented in this document and what you may see online are due to 
Web Page Upgrades not yet reflected in this document. The screen displays incorporated into this document are to give the 
reader a sense of the functionality of the  Web Interface to THEMIS Science Software. 
 
Please see copy of the Themis Home Web Page on the Next Page. 
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   THEMIS Web Site - Home Page 
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2.2      THEMIS Data Web Pages 
 
The THEMIS Data Drop Down Menu has seven Options.  

• Overview - A Data Overview and convenient location to Instruments, Orbits, Data Descriptions and more. 
• Usage Rules - displays the Rules for using the THEMIS Data website  (Rules of the Road).  
• Summary Plots which will allow you to look at Summary Plots of one Probe, Multiple Probes, Ground 

Magnetometer, All Sky Imager or Orbits Data. Download Data to Download THEMIS Data.  
• Data Retrieval - Menu of the following options: 

Data Files All -ftp site of all themis data directories and data files 
Data Files By Platform - allows selection to either a probe, gmag or flatsat data files 
Data Files By Group - allows selection by Probe and Instrument 

• Data Descriptions - which will lead you to the documentation ftp site where the 'Science Data Variable 
Descriptions' document can be found.  

• Event List which will display the Events ftp site. 
 
Please note: If using THEMIS Science Software Data Analysis Tools there is no need to use the  
Data Retrieval - Data Files By Group Option. Please see screen displays below for all options. 

 

    THEMIS Data Dropdown Menu 
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   THEMIS Data Usage Rules Web Page 
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   THEMIS Data Summary Plot Web Page  
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  THEMIS Summary Web Page - View Plot Key Button 
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   THEMIS Data Retrieval - ALL 
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    THEMIS Data Retrieval - By Platform 

 

   THEMIS Data Retrieval - By Group  
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Selecting Data Descriptions will display this web page and then click on ftp 

 

Will display a list of documents on the ftp site - Click on 
Science_Data_Variable_Descriptions and then choose the .xls or .pdf version 
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When you select the Event List on the data dropdown menu the following ftp site and related files are found. 

 

 

   THEMIS Event List - ftp site
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2.3 THEMIS  Science Software Web Page 
 
The THEMIS Science Software Drop Down Menu has three options. Software which displays a web page for downloading 
the latest release of the THEMIS Science Software Data Analysis Tools, Documentation, Registering to be notified of Future 
Releases of the Software, Download not yet released Software and Contacting the THEMIS Science Support Team with Help 
Requests. Developers, options to read about how to develop and contribute Software to THEMIS Science Software. 
Documentation which provides a link to the THEMIS Science Software Documentation ftp site. Enhancements, which will 
display the latest Accomplishments and Enhancements (A&E). The previous month's A&E is available as well.  
Please note: If you download the not yet released Software, this Software may not have been tested (you are on your own).  
Please see screen displays below. 

 

   THEMIS Science Software Drop Down Menu 
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   THEMIS Science Software Web Page 
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When  you click on Download the latest release on a Windows machine A File Download dialogue box will be displayed. 
Click on 'Open' and the WinZip box will appear. Select the Extract icon to download the unzipped versions of the THEMIS 
Science Software to your  computer. Notice the Extract display will ask you where to put the downloaded files. Please see 
Screen displays on th this and the next page. 
     

  

 

 

  THEMIS Science Software - Download Software 
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Recommendation is put the Software where you can easily find it as you will need to set the IDL path. 
 

  
 

  THEMIS Science Software - Download Software  
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   THEMIS Science Software - HTML Docs 
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 THEMIS Science Software - Registration  for Notification   

  

  

  

 THEMIS Science Software - Download Not Yet Released Software
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2.4 THEMIS  Science Software - For Developers Web Page 
 
The THEMIS Science Software for Developers Web Page has links to aide software developers how to develop and 
contribute software to the THEMIS Science Software library. The 'Additional Documentation' option will link you to the ftp 
site where current THEMIS Science Software documentation can be found. 

 

 

  THEMIS Software - For Developers Web Page  
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When you click on the Documentation Option on the THEMIS Software Dropdown menu the following web page appear. 
Click on ftp site and you will be transferred to the THEMIS Document ftp site. 
 

 
 
    
    THEMIS Documentation Web Page
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THEMIS Software Drop Down Menu - Documentation ftp site
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2.5 THEMIS  Contact Us Web Page 
 
The THEMIS Contact Us Web Page lists the contact information for the THEMIS Principal Investigator as well 
as the Co-Investigators for each THEMIS Instrument. In addition there is an option to send a Help Request to the THEMIS 
Science Support Coordinator with comments, observations, problems or questions. The Help Request form and process will 
be explained in more detail in Section 3. Please see the screen display below. 
 

 
 
 

   THEMIS Software Contact Us Web Page 
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3 THEMIS Science Support Help System 

3.1 THEMIS Science Support Help Process 
 
The THEMIS Science Support Help Process for users who have Comments, Observations, Problems or Questions concerning 
data, a document, download, GUI, Plot, Software, Web Interface or any other issue not listed.  The Help Process is a bit 
different for Step 1 if you are using the Web or the GUI Interface. 
 
For the Web to Help Request Form Interface: 
From either the Software or Contact Us Web Pages (example on previous page) the user  will see the following: 
For comments, observations, problems or questions about data access, software or web site content  
please contact the THEMIS Science Support Team.  
   
If you click on THEMIS Science Support Team a Themis Science Support Help Request Form (example in Section 3.2) 
will be displayed. The user fills out the form and hits 'Submit'.  Depending on your computer and email application the 
processing will be different for the email to be sent. For some computers that is all you need to do and the form is sent 
automatically. If you have a PC running Windows a box will be display asking you  which email Application you use. If you 
use a desktop email application like Outlook, Outlook Express, select that button, hit OK and the Form will be automatically 
sent to the Support Coordinator. If you choose either of the two other options (Internet Email or Other) Windows will guide 
you through a three step process to send your email. Again, if not using windows (e.g. Mac, Linux or Unix) the process 
maybe different. Yet the main goal is for the Help Request Form to be sent to THEMIS_Science_Support@ssl.berkeley.edu. 
 
For the GUI to the Help Request Form Interface: 
By clicking on the “HELP" drop down menu on the GUI Main window or if the THEMIS Science Software GUI detects and 
error, a Help Request Form will be displayed (example in Section 3.3). Fill out the form and then click on 'Save'. Be sure to 
save somewhere you can find it. Then if reporting a bug please save and send your history file. Do this by first selecting 
“History Window” on the “View” drop down menu and then clicking on “Save” at the bottom of the History window. The 
suggestion is to put your Help Request Form and Saved History file in the same location At this point you can address your 
email to THEMIS Science Support Team, attach your Help Request Form and your History file and send.  
 
The remaining steps are the same for either the Web or GUI Interface. 
 Step 2: User sends any additional information (logs, error messages, etc) to THEMIS_Science_Support@ssl.berkeley.edu. 
 
Step 3: The Support Coordinator will log in your help request, send you back an  email confirming receipt of your help 
request with your Help Request Number. The Support Coordinator will also forward your Help Request and any attachments 
to the person (Actionee) who will investigate and answer your Help Request. 
 
Step 4: The Actionee will contact the User to respond to the comment, observation, problem or question. 
 
Step 5: Feel free at any time to send an email to the Support Coordinator requesting status of your request. 
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3.2 THEMIS Science Support Help Form - Web Form 
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3.3 THEMIS Science Support Help Form  
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4  THEMIS DATA 
This section describes the THEMIS data, as seen by the THEMIS Data Analysis Software. 

4.1 THEMIS DATA Overview  
THEMIS data is available in 3 levels 
Level 0 telemetry packet format, overlaps removed and formatted into daily files 
Level 1 CDF data files, contain raw telemetry data 
Level 2 CDF data files, calibrated data 
 

4.2 THEMIS DATA Quantity Summary 
The table on the next few pages summarizes the data types recognized by TDAS. They will include the variable names as 
they appear on an Instrument's GUI Widget as well as in the GUI Main widget's Active Data window (GUI concepts will be 
discussed in Section 6). Please note that in the table below the variable names will not include their probe prefix (e.g. tha_ for 
a probe 'A' variable). 
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Instrument  Level Data Name Description

ASI  L1 asf_???? All-sky imager full resolution images of 256x256 pixels
(???? = 4-letter code of ground station)

ast_???? All-sky imager thumbnail images of 32x32 pixels
(???? = 4-letter code of ground station)

ASK L1 ask_???? All-sky imager keogram images of 256 pixels
(???? = 4-letter code of ground station)

ESA L0 or L2 For ESA: ? = f or r or b f=full,  r=reduced, b=burst
pei?_density ion density

pei?_t3 diagonalized ion temperature
pei?_en ion energy spectrogram

pei?_en_eflux ion energy flux spectrogram
pei?_velocity ion velocity (DSL)

pei?_velocity_??? ion velocity (???=DSL or GSE or GSM)
pei?_ptens ion pressure tensor (DSL)
peif_mftens ion momentum flux tensor (DSL)
pei?_magt3 ion temperatures in B frame

pei?_avgtemp trace of diagonalized temperature tensor divided by 3
pei?_vthermal ion thermal velocity

pei?_symm direction of pressure tensor symmetry (DSL)
pei?_symm_ang angle between symmetry direction and B

pei?_ang ion angle spectrogram
pei?_tot total ion count

pei?_en_counts ion count vs. energy
pei?_mode ion instrument mode

pee?_density electron density
pee?_t3 diagonalized electron temperature
pee?_en electron energy spectrogram

pee?_en_eflux electron energy flux spectrogram
pee?_velocity electron velocity (DSL)

pee?_velocity_??? electron velocity (???=DSL or GSE or GSM)
pee?_ptens electron pressure tensor (DSL)

pee?_mftens electron momentum flux tensor (DSL)
pee?_magt3 electron temperatures in B frame

pee?_avgtemp trace of diagonalized temperature tensor divided by 3
pee?_vthermal electron thermal velocity

pee?_symm direction of pressure tensor symmetry (DSL)
pee?_symm_ang angle between symmetry direction and B

pee?_ang electron angle spectrogram
pee?_tot total electron count

pee?_en_counts electron count vs. energy
pee?_mode electron instrument mode  
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Instrument  Level Data Name Description
SST L1 or L2 For SST: ? = f or r or b f=full,  r=reduced, b=burst

psi?_# # = same quantities as for ESA
pse?_# # = same quantities as for ESA

MOM L1  and L2 peim_density  ESA ion density
(on-board peim_flux     ESA ion flux
moments) peim_mftens   ESA ion momentum flux tensor

peim_eflux    ESA ion energy flux
peim_velocity ESA ion velocity
peim_press    ESA ion pressure
peem_density  ESA electron density
peem_flux     ESA electron flux

peem_mftens   ESA electron momentum flux tensor
peem_eflux    ESA electron energy flux
peem_velocity ESA electron velocity
peem_press    ESA electron pressure

L1 and L2 psim_# # = SST quantities (same as for ESA)
psem_# # = SST quantities (same as for ESA)

EFI L1 or L2 eff E field, fast survey/full orbit, 3D
efp E field, particle burst, 3D
efw E field, wave burst, 3D

eff_dot0 E field, fast survey/full orbit, 3D, using E dot B=0
efp_dot0 E field, particle burst, 3D, using E dot B=0
efw_dot0 E field, particle burst, 3D, using E dot B=0

eff_0 E field, fast survey/full orbit, 3D, using Ez=0
efp_0 E field, particle burst, 3D, using Ez=0
efw_0 E field, particle burst, 3D, using Ez=0

efs On-board spin-fit electric field
efs_0 On-board spin-fit electric field using Ez=0

efs_dot0 On-board spin-fit electric field using E dot B=0
vaf Voltage, processor A, fast survey/full orbit
vap Voltage, processor A, particle burst
vaw Voltage, processor A, wave burst
vbf Voltage, processor B, fast survey/full orbit
vbp Voltage, processor B, particle burst
vbw Voltage, processor B, wave burst

ef?_hed 16-byte packet header for analogous data type; ?=f or p or w
ef?_raw raw data for analogous data type; ?=f or p or w
va?_hed 16-byte packet header for analogous data type; ?=f or p or w
va?_raw raw data for analogous data type; ?=f or p or w
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Instrument  Level Data Name Description
FBK L1 only fb1 Filter Bank 1 (E and/or B)

fb2 Filter Bank 2 (E and/or B)
fbh Filter Bank high frequency (100-300kHz)

L1 and L2 fb_hff High-frequency filter peak and average values
fb_eac12 Spectrogram E field AC component, sensors 1&2 (spin plane)
fb_eac34 Spectrogram E field AC component, sensors 3&4 (spin plane)
fb_eac56 Spectrogram E field AC component, sensors 5&6 (axial)
fb_edc12 Spectrogram E field DC component, sensors 1&2 (spin plane)
fb_edc34 Spectrogram E field DC component, sensors 3&4 (spin plane)
fb_edc56 Spectrogram E field DC component, sensors 5&6 (axial)
fb_scm? Spectrogram SCM? (search coil) ; ?=1,2,3 (three axes)

fb_v? Spectrogram floating potential of sensor ?=1,2,3,4,5,6

FFT L1 and L2 ffp_16 FFT power spectrum in particle burst x 16 frequencies
(on-board) ffp_16_dbpara FFT power spectrum for dB (parallel)

ffp_16_dbperp FFT power spectrum for dB (perpendicular)
ffp_16_eac12 FFT power spectrum for AC component E12
ffp_16_eac34 FFT power spectrum for AC component E34
ffp_16_eac56 FFT power spectrum for AC component E56
ffp_16_edc12 FFT power spectrum for DC component E12
ffp_16_edc34 FFT power spectrum for DC component E34
ffp_16_edc56 FFT power spectrum for DC component E56
ffp_16_epara FFT power spectrum for E (parallel)
ffp_16_eperp FFT power spectrum for E (perpendicular)
ffp_16_scm? FFT power spectrum for SCM? ; ?=1,2,3 (axes)

ffp_16_v? FFT power spectrum for V? ; ?=1,2,3,4,5,6 (sensors)
ffp_32_# # = same quantities in particle burst x 32 frequencies
ffp_64_# # = same quantities in particle burst x 64 frequencies
ffw_16_# # = same quantities in wave burst x 16 frequencies
ffw_32_# # = same quantities in wave burst x 32 frequencies
ffw_64_# # = same quantities in wave burst x 64 frequencies

FGM L1 and L2 fgl B field, low telemetry (low data rate)
fgh B field, high telemetry (high data rate)
fge engineering data (decimated from FGH)

L2 only fgs B field, spin-resolution magnetic field B in DSL
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Instrument  Level Data Name Description
FIT L2 only efs On-board spin-fit electric field (EFI) data
(on-board) efs_0 On-board spin-fit electric field (EFI) using Ez=0

efs_dot0 On-board spin-fit electric field (EFI) using E dot B=0
efs_sigma Variance of onboard spin-plane electric field spin fit

fgs  On-board spin-fit FGM data
fgs_sigma Variance of onboard spin-plane magnetic field spin fit

fit SpinFIT file E&B raw data
fit_bfit FGM spinfit calibrated data: A,B,C,sig,avg
fit_efit EFI spinfit calibrated data: A,B,C,sig,avg

GMAG L2 mag_???? Ground magnetometer data in DHZ coordinates
(???? = 4-letter code of ground station)

SCM L1 and L2 For SCM: ? = f or p or w f=fast survey, p=particle burst, w=wave burst
scf waveform fast survey (DSL)
scp waveform particle burst (DSL)
scw waveform wave burst (DSL)

sc?_misalign misalignment of Z axis from spin axis
sc?_dc X-Y (spin plane) values of the DC field in DSL 

sc?_iano time discontinuities of data
sc?_cal calibrated data (unit depends on selected step)

STATE L1 state_pos GEI position, xyz
state_vel GEI velocity, xyz

state_man  Maneuver flag
state_roi  Regions of interest

state_spinras spin axis right ascension, deg
state_spindec spin axis declination, deg

state_spinalpha Geom to spin axis, Euler alpha, deg
state_spinbeta Geom to spin axis, Euler beta, deg
state_spinper   spin period, sec
state_spinphase spin phase, deg
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5. THEMIS DATA ANALYSIS SOFTWARE 
 
The THEMIS Data Analysis Software (hereafter referred to as TDAS) is IDL-based.  TDAS routines can be used to 
download, open, analyze and plot L1 or L2 data and process L1 data into L2 data quantities.  There are two main ways to use 
the programs: with the command line interface or with the GUI interface. 
 
Other features include coordinate transformations and utility routines to translate data into other products (e.g., ascii) as 
necessary. 
 

5.1 System Requirements 
The THEMIS Data Analysis Software requires an IDL developer’s license for Windows or a UNIX-like operating system, 
e.g. Solaris, Linux, or Mac OS X.  The software has been tested on IDL 6.3,  6.4 and 7.0 but should work on any level of IDL 
above 6.2.  There is a patch to IDL, which is recommended for best handling of the CDF file format that is used by the 
THEMIS data files.  See:  http://cdf.gsfc.nasa.gov/html/cdf_patch_for_idl6x_new.html  
If you are using IDL 6.2, or if you are using Intel Mac with any version of IDL (up to 6.4), or if you are using IDL 7.0 you 
must install this patch to read CDF files properly. 
 

Mac OS X notes:   
 
You need X11 to view plots and use the GUI in IDL.  You can search for X11 in the Spotlight to see if the X11 
application is installed on your system.  X11 is available on your Mac installation disks, but may not be installed by 
default.   
 
There is a known problem, mentioned in the IDL 6.3 release notes, which affects all IDL users running Mac OS 10.4 
(Tiger). The  tlimit command will lock up IDL because the plot window will not receive any mouse clicks. 
Workaround: Change the X11 start-up parameters. Do the following: 
1. Open any terminal window (in the X11 application menu bar, you can choose xterm from the applications 

menu) 
2. Enter the following at the shell prompt: 

defaults write com.apple.x11 wm_click_through -bool true   
3. Quit X11 (if it is running). 
The new default will take effect the next time you start X11, and it will persist from that point (i.e., you will not 
have to make the change again). 

5.2 Known Limitations 
 1. Incompatibilities with Solar Software (SSW).  There exist some name clashes if both TDAS and SSW are on your 
     IDL_PATH. 
 2. ASI data: ASF (full resolution ASI data) requires a 64-bit machine to load more than 1 hour’s worth of data. 
 3. "Warning for IDL 7.0 users.  A bug has been found with IDL 7.0 and CDFs that cause crashes on any operating  
       system when loading CDF data.  All IDL 7.0 users must go to:  
         http://cdf.gsfc.nasa.gov/html/cdf_patch_for_idl6x_new.html and install this patch." 

4. The IDL executive command .reset_session does not work for the THEMIS GUI software. Please use the                              
command .full_reset_session to reset IDL sessions.. 

5.3 Installation and Configuration 
Getting started is usually as simple as of downloading the code and setting up your IDL path, according to the instructions, 
below.  
 
For a new installation: 
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1. Download and expand the latest TDAS release .zip file.  See section 2.3 THEMIS Science Software – Download 
Software. 

2. Create a directory called TDAS into which you will copy the latest software. 
3. Move the tdas_x_xx folder into the TDAS directory you created. 
4. Configure IDL to search the TDAS directory for IDL programs.  See section 5.3.1 IDL PATH setup. 

 
For an upgrade of an existing installation of TDAS, as per the above 4 steps: 

1. Remove old tdas_x_xx from the TDAS directory. 
2. Download and expand the latest TDAS release .zip file. 
3. Copy the new tdas_x_xx directory into the pre-existing TDAS directory. 
4. Re-start IDL. 
 

5.3.1 IDL PATH setup 

5.3.1.1 IDL PATH Setup on Windows (and IDLDE on UNIX, Linux and Mac) 
 
For Windows or IDLDE on UNIX, you can use the File->Preferences widget to set up the path so IDL can find the THEMIS 
IDL files.   
 

UNIX Note: If you use IDLDE on UNIX-like systems, these instructions only work if you do not set the IDL_PATH 
environment variable before you call IDLDE.  If IDLDE does not allow you to set the path by following these 
instructions, then follow the instructions for UNIX installation, below. 

 
Start IDL (Windows) or IDLDE (UNIX, Linux, Mac). 
 
Go to File->Preferences 
Select the ‘Path’ tab. 
 
If <IDL_DEFAULT> is not present, press ‘Insert Standard Libraries’ 
 
Press Insert 
Browse to find the TDAS directory you created (see section 5.3 Installation and Configuration) 
Check the box to indicate “search subdirectories” 
 

5.3.1.2 IDL PATH Setup for IDL Command Line (UNIX, Linux or Mac OS X) 
 
For the command line version of IDL, installation consists of setting up the IDL_PATH environment variable 
 
Simply set the IDL_PATH environment to search all subdirectories of the TDAS directory you created in section 5.3 
Installation and Configuration.   
 

for csh or tcsh, place the following in your .cshrc file 
setenv IDL_PATH ’<IDL_DEFAULT>:+/path/to/tdas’ 
 

for bash or sh, place the following in your .bashrc (Linux, Solaris) or .bash_profile (Mac) file: 
export IDL_PATH=’<IDL_DEFAULT>:+/path/to/tdas’ 
 

Mac OS X Notes: 
You can edit your .bash_profile file using the standard Mac TextEdit program (normally, it's impossible to open 
'hidden' files beginning with '.' using TextEdit or the Mac Finder) 
 
In the Terminal, type (or cut-and-paste) 
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/Applications/TextEdit.app/Contents/MacOS/TextEdit ~/.bash_profile 
 
That will open the .bash_profile file in the standard Mac text editor.  The following configurations are recommended 
to enable you to use IDL from the Terminal. 
# Configurations to make IDL and TDAS work from the Terminal 
export DISPLAY=:0.0 
IDL_LOC='/Applications/rsi/idl_6.3' 
source ${IDL_LOC}/bin/idl_setup.bash 
export IDL_PATH='<IDL_DEFAULT>:/path/to/tdas' 
# End configurations for IDL and TDAS 

 
Note that IDL_LOC may vary, depending on version of IDL installed.  Search for actual location of IDL using 
Spotlight. 
 
Tip: 
You can drag the 'tdas' directory from the Finder into the TextEdit or Terminal window to paste the actual path for 
/path/to/tdas. 
 
After saving the file, be sure to exit the TextEdit application from the  menu bar, so you can get your command line 
prompt back! 

5.3.2 Data Directory Setup 
The THEMIS Data Analysis Software requires a local data directory in which THEMIS data files can be cached.  The 
software will attempt to create the local data directory for you at the following default location, depending on your operating 
system. 
 
OS LOCAL_DATA_DIR 
Windows C:\data\themis 
Solaris, Linux, Mac OS X ~/data/themis 
 
These locations should work as-is for most installations; however, if you don’t have administrative privileges to create the 
data directory in the above locations, you can have your system administrator create it for you, or you can configure the 
THEMIS Data Analysis Software to use an alternate location.  See Remote Data Access and Local Data Cache (Sections 
5.5.9 – 5.5.11) for information about configuring an alternate location. 
 

5.4 How to Get Started 
Assuming you have the software installed, the best place to start is with a crib sheet.  The crib sheets in the 
idl/themis/examples folder give end-to-end examples of how to load, process and plot the data available for a given  
instrument. 
 

5.4.1 Crib Sheets in idl/themis/examples 
 
thm_crib_asi Crib sheet for loading and displaying All Sky Imager and Keogram data. 
thm_crib_calc Crib sheet for the mini-language program ‘calc’ 
thm_crib_cotrans_lmn Crib sheet for coordinate transform to ‘LMN’ coordinates 
thm_crib_dproc Crib sheet for testing some common data processing routines 
thm_crib_efi Crib sheet for Electric Fields Instrument waveforms. 
thm_crib_esa_da Crib sheet for analysis of ESA particle distributions 
thm_crib_esa_moments Crib sheet for ground processed ESA moments 
thm_crib_esa_read_gmoms Crib sheet for reading ground-processed ESA moments 
thm_crib_esa_slice2d Crib sheet for creating 2d ‘slices’ of ESA particle distributions 
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thm_crib_export Crib sheet for exporting THEMIS data and/or plots in common data 
formats. 

thm_crib_fac Crib sheet showing how to transform into field-aligned coordinates 
thm_crib_fbk Crib sheet for Filter Bank. 
thm_crib_fft Crib sheet for on-board Fast Fourier Transform data. 
thm_crib_fgm Crib sheet for Flux Gate Magnetometer 
thm_crib_fit Crib sheet for on-board Fields Spin Fit 
thm_crib_gmag Crib sheet for GMAG, including wavelet demo. 
thm_crib_make_ae Crib sheet for creating  geomagnetic AE indices 
thm_crib_mom Crib sheet for on-board particle Moments. 
thm_crib_mva Crib sheet for transformation into minimum variance analysis coordinates 
thm_crib_overplot Crib sheet for creating overview plots 
thm_crib_part_getspec Crib sheet for generating angular particle spectra 
thm_crib_plotxy Crib sheet with for plotxy, which creates 2d plots for 3d quantities 
thm_crib_plotxyvec Crib sheet for plotxyvec, which plots arrow on plotxy, plotxyz images 
thm_crib_plotxyz Crib sheet with for plotxyz, which creates isotropic spectrographic plots 
thm_crib_scm Crib sheet for Search Coil Magnetometer 
thm_crib_sst Crib sheet for Solid State Telescope (SST).  
thm_crib_sst_contamination Crib sheet for SST contamination removal 
thm_crib_state Crib sheet for State data – loading and plotting probe position data 
thm_crib_tplot Crib sheet for using tplot plotting package, using GMAG data as an 

example. 
thm_crib_tplot_overlay Crib sheet showing how to overlay spectra on other spectra 
thm_crib_tplotxy Crib sheet with for plotxy; creates 2d plots for 3d quantities in tplot 

variables 
thm_crib_trace Crib to demonstrate use of Tsyganenko trace routines, and means for 

generating plots of trace routines. 
thm_crib_twavpol Crib for generation of wave polarization from SCM (Search Coil 

Magnetometer) data 
thm_map_examples Examples for mapping Ground Base Observatories (GBO) 
 
You can run any of the crib sheets by typing  
.run <thm_crib_xxx> 

 
when execution stops at a 'stop' command in the crib sheet, type 
.c 

to continue. 
 
Alternatively, you can cut and paste from the crib sheet to the command line. 
 
The crib sheet thm_map_examples is not in the same format as the other crib sheets: it defines some procedures which you 
can then run for yourself, or use as examples for your own code. 
 

5.4.2 IDL Documentation for TDAS 
 
To find more information on any of the TDAS routines used in the crib sheets, use: 
• The source code of the crib sheets, which is included in the idl/themis/examples directory of the software distribution. 
• HTML help included with the software distribution: point your web browser to idl/_tdas_doc.html at the location where 

your TDAS software is installed locally. 
• IDL XDOC widget.  At the IDL prompt, type: 

xdoc 



 
 
 
 

 

NAS5-02099 File: THEMIS_Science_Data_Analysis_Software_Users_Guide   40  

• IDL doc_library procedure.  At the IDL prompt, type: 
doc_library, ‘command_name’  

 
Sample THEMIS routine documentation: 

 
;+ 
;Procedure: THM_LOAD_GMAG, 
; thm_load_gmag, site = site, datatype = datatype, trange = trange, $ 
;                level = level, verbose = verbose, $ 
;                subtract_average = subtract_average, $ 
;                subtract_median = subtract_median, $ 
;                varname_out = varname_out, $ 
;                subtracted_values = subtracted_values, $ 
;                downloadonly = downloadonly, $ 
;                valid_names = valid_names 
;keywords: 
;  site  = Observatory name, example, thm_load_gmag, site = 'bmls', the 
;          default is 'all', i.e., load all available stations . This 
;          can be an array of strings, e.g., ['bmls', 'ccmv'] or a 
;          single string delimited by spaces, e.g., 'bmls ccnv' 
;  datatype = The type of data to be loaded, for this case, there is only 
;          one option, the default value of 'mag', so this is a 
;          placeholder should there be more that one data type. 'all' 
;          can be passed in also, to get all variables. 
;  TRANGE= (Optional) Time range of interest  (2 element array), if 
;          this is not set, the default is to prompt the user. Note 
;          that if the input time range is not a full day, a full 
;          day's data is loaded 
;  level = the level of the data, the default is 'l2', or level-2 
;          data. A string (e.g., 'l2') or an integer can be used. 'all' 
;          can be passed in also, to get all levels. 
;  /VERBOSE : set to output some useful info 
;  /SUBTRACT_AVERAGE, if set, then the average values are subtracted 
;                     from the loaded variables, 
;  /SUBTRACT_MEDIAN, if set, then the median values are subtracted 
;                     from the loaded variables, 
;  varname_out= a string array containing the tplot variable names for 
;               the loaded data, useful for the following keyword: 
;  subtracted_values = returns N_elements(varname_out) by 3 array 
;                      containing the average or median (or 0) values 
;                      subtracted from the data. 
;  /downloadonly, if set, then only download the data, do not load it 
;                 into variables. 
;  no_download: use only files which are online locally. 
;  relpathnames_all: named variable in which to return all files that are 
;          required for specified timespan, probe, datatype, and level. 
;          If present, no files will be downloaded, and no data will be loaded. 
;  /valid_names, if set, then this will return the valid site, datatype 
;                and/or level options in named variables, for example, 
; 
;                thm_load_gmag, site = xxx, /valid_names 
; get_support_data = does nothing.  present only for consistency with other 
;                load routines 
;   
;Example: 
;   thm_load_gmag, site = 'bmls', trange = 
;   ['2007-01-22/00:00:00','2007-01-24/00:00:00'] 
; 
;Written by: Davin Larson,   Dec 2006 
; 22-jan-2007, jmm, jimm@ssl.berkeley.edu rewrote argument list, added 
; keywords,  
; 1-feb-2007, jmm, added subtract_median, subtracted_value keywords 
; 19-mar-2007, jmm, fixed the station list... 
; $LastChangedBy: jimm $ 
; $LastChangedDate: 2007-05-21 19:44:54 -0400 (Mon, 21 May 2007) $ 
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; $LastChangedRevision: 678 $ 
; $URL: svn+ssh://thmsvn@ambrosia.ssl.berkeley.edu/repos/thmsoc/branches/QA/idl/themis/ground/thm_load_gmag.pro $ 
;- 
 

 

5.5 Software Functions  
This section described the functionality of  the THEMIS software.  The examples are given using the command line interface, 
but the concepts are the same for the GUI. 
 

5.5.1 Loading THEMIS Data 
The THEMIS software is set up to work with Level 1 THEMIS data by default. Level 1 data is loaded and calibrated creating 
data quantities which are the same as the Level 2 products. The exceptions are GMAG (ground magnetometer), FGM (Flux-
Gate Magnetometer), and FBK (Filter Bank) data, which are input from Level 2 files.  In future versions we will change the 
default to Level 2 when reliable Level 2 files become available for each instrument. With the exception of ESA data, TDAS 
does not work with Level 0 data, and instead works with the Level 1 in CDF data format. 
 
It is also possible to load raw Level 1 data.  Calibration routines are available for those who want to have full access to 
intermediate outputs, settings of calibration parameters, diagnostic outputs, etc. 
 
The THEMIS software automatically creates a local data cache which mirrors the structure of the THEMIS data archive.  The 
software is written such that the default settings will work for the majority of users.  The location of the THEMIS data 
archive is also found automatically by the software. 
 
To download some data and load it into IDL, specify a timespan and type of data you want to load.  If the data does not exist 
locally on your local_data_dir, it will be downloaded automatically before it is loaded into IDL. 
 
 
At the IDL prompt, type: 
 
timespan, '2006-11-11', 1, /day 

Then, use one of the thm_load commands, e.g. 
 
thm_load_gmag, site='ccnv' 

 
List of routines for loading data: 
thm_load_asi Load All-Sky Imager data for any ground station (by keyword) or all available. 
thm_load_ask Load All Sky Keogram data for all observatories. 
thm_load_efi Load efi waveforms 
thm_load_esa Load ElectroStatic Analyzer data (for L2 esa data) 
thm_load_esa_pkt Load Level 0 ESA data 
thm_load_fbk Load Filter Bank data 
thm_load_fft Load on-board Fast Fourier Transform data. 
thm_load_fgm Load fgm waveforms (choice of fgl, fgh…) 
thm_load_fit Load On-Board Fields Spin-Fit data 
thm_load_scm Load Search Coil Magnetometer data. 
thm_load_gmag Load ground magnetometer data for any ground station. 
thm_load_hsk Load housekeeping data – all or one by keyword.  
thm_load_mom Load on-board moments data (only density moment is currently valid) 
thm_load_scm Load SCM waveform. 
thm_load_spin Load THEMIS spin model parameters 
thm_load_sst Load Solid State Telescope data. 
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thm_load_state Load Orbit and Attitude data 
Standard Load Procedure Keywords:  
SITE string: ground station name, or a list of ground station names, or ‘all’ 
PROBE string: probe name, or a list of probe names, or ‘all’.  e.g. ‘a b c’ 
DATATYPE type of CDF variable for the given instrument. 
LEVEL Level of data file to load: 'l1' or 'l2' default is usually ‘l1’. 
TYPE ‘raw’ or ‘calibrated’. applies to ‘l1’ data only.  ‘Calibrated’ is the default. 
VALID_NAMES Return valid names for DATATYPE, SITE, PROBE, and LEVEL 
VERSION Version of CDF file to load (useful for STATE data): 'v01', 'v02' 
GET_SUPPORT_DATA Get support data quantities from CDFs well as data quantities, only used for ‘l1’ 

data. 
CDF_DATA Return a structure containing data and metadata from CDF. 
 
Note that all of these keywords are not present for all of the different load routines. This is true for the ESA, SST and MOM 
load routines which are under development. 

5.5.2 General Conventions: variable name construction and reference 
The command line interface of TDAS provides a general interface for referring to  a data quantity, based on keywords.  The 
lists in these keywords can be arrays of strings, or scalar strings containing space-separated lists. 
PROBE : specifies the probe, or probes of interest: ‘a b c’ or [‘a’, ‘b’, ‘c’] 
DATATYPE: specifies the type of data, for a given instrument: corresponds to name in CDF file 
SUFFIX: a suffix to the variable name 
 
The data is loaded into variables with  the following name: 
tha_bbb_suf 
where a is the probe designation, bbb is the datatype designation, and _suf is the optional suffix. 
For some data, a midfix is added before the datatype: e.g. for all STATE and HSK data a midfix is added before the datatype 
it in the variable name.  e.g. 
tha_state_pos 
In this example, the datatype is POS, but the state_ midfix had been added before it in the name. 
 
The various thm_load and thm_cal (calibration) routines, as well as thm_cotrans (coordinate transform) accept the above 
keywords to determine which data to operate upon. 
 
General-purpose routines (e.g. tplot) contained in TDAS can refer to sets of variables using glob-style patterns. For example: 
 
th?_???_raw 
 
refers to data for all probes for all non-state data types, which have the ‘_raw’ suffix. 
 
th[ab]_fg? 
 
refers to FGL, FGH, and  FGE for probes A and B. 
 

5.5.3 Plotting the Data 

5.5.3.1 Plotting with Tplot 
Documentation that explains how to use these routines in detail can be found in the headers at the beginning of the procedure 
files, in the cribs, or by using the 'doc_library' command.  For example: doc_library,'tplot' 
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Plotting routines: 
tplot General purpose time plotting utility for creating plots of lines and spectragrams. 
tplot_names Lists current stored data names that can be plotted with the TPLOT routines. 
tplot_options Sets global options for the tplot routine. 
options Sets options for specified tplot variable(s) 
tlimit Zoom into or out of a tplot. 
xlim Sets x-axis limits for specified tplot variable(s) 
ylim Sets y-axis limits for specified tplot variable(s) 
zlim Sets z-axis limits for specified tplot variable(s) 
get_data Get data out of a tplot variable into a structure containing a time tag array and a data array. 
store_data Store a data array structure into a tplot variable. 
 
Cribs: idl/themis/examples/thm_crib_tplot.pro 
 idl/ssl_general/tplot/_get_example_dat.pro 
 idl/ssl_general/tplot/_tplot_example.pro 
 idl/ssl_general/tplot/_tplot_demo.pro 
 
tplot – use to create a time series plot of user defined quantities. 
idl/ssl_general/tplot/tplot.pro 
 

tplot, 1                   ; Plot the first quantity (as revealed by calling tplot_names) 
tplot, [1,2,3]             ; Plots a stack plot of the first 3 data quantities. 
tplot,'amp slp flx2'       ; Plots the named quantities 
tplot, ‘th?_fgh’           ; Plots a stack plot of High Rate Flux Gate Magnetometer data for all 
                           ; available probes.  
tplot,'flx1',/ADD_VAR      ; Add the quantity 'flx1' to previous plot. 
tplot                      ; Re-plot the last variables. 
tplot,var_label=['alt']    ; Put Distance labels at the bottom. 

 
tplot_names – use to print a list of acceptable names to plot and to get info on those tplot variables. 
idl/ssl_general/tplot/tplot_names.pro 
 

tplot_names,'*3dp*'               ; display all names with '3dp' in the name 
tplot_names,'ehspec',/verbose     ; print out more info on the data structure in ‘ehspec’ 
tplot_names,/time_range           ; print out the time range for tplot var in memory 

  
tplot_options – use to control the plotting of all tplot variables (e.g. the title, margins, etc. of the plot window). 
idl/ssl_general/tplot/tplot_options.pro 
 

tplot_options,'title','My Data'              ; Set title 
tplot_options,'xmargin',[10,10]              ; Set left/right margins to 10 characters 
tplot_options,'ymargin',[4,2]                ; Set top/bottom margins to 4/2 lines 
tplot_options,'position',[.25,.25,.75,.75]   ; Set plot position (normal coord) 
tplot_options,'wshow',1                      ; de-iconify window with each tplot 
tplot_options,'version',3                    ; Sets the best time ticks possible 
tplot_options,'window',0                     ; Makes tplot always use window 0 
tplot_options,/help                          ; Display current options 
tplot_options,get_options=opt                ; get option structure in the variable opt. 
tplot_options,'ygap',0.0                     ; eliminate the vertical spacing between panels 

 
options – use to control the plotting of one or more tplot panels. This procedure can be used to set all IDL plotting keyword 
parameters (i.e. psym, color, linestyle, etc) as well as some keywords that are specific to tplot (i.e. panel_size, labels, etc.) 
idl/ssl_general/tplot/options.pro 
 

options, ‘tvar_name(s)’,'panel_size',1.5 ; Change the relative panel width 
options, ’tvar_name(s)’,'labflag',-1     ; Set evenly spaced labels 
options, ’tvar_name(s)’,'labflag',0      ; No labels 
options, ’tvar_name(s)’,'spec',1         ; set option to produce a spectrum plot 
options, ’tvar_name(s)’,'y_no_interp',1  ; prevent y-axis interpolation 
options, ’tvar_name(s)’,'y_no_interp',0  ; allow y-axis interpolation 
options, ’tvar_name(s)’,'ystyle',1       ; force exact y-axis limits 
options, ’tvar_name(s)’,'ystyle',0       ; return to autoranging 
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options, ’tvar_name(s)’,'spec',0         ; change to multi-line plot 

 
tlimit – defines time range for tplot. 
idl/ssl_general/tplot/tlimit.pro 
 

tlimit                     ; Use the cursor to set time range 
tlimit,'12:30','14:30' 
tlimit, 12.5, 14.5 
tlimit,t,t+3600            ; t must be set previously 
tlimit,/FULL               ; zooms to full time range available 
tlimit,/LAST               ; previous limits 

 
xlim, ylim, zlim – To set plotting limits for plotting routines.  zlim typically applies to spectragrams. 
idl/ssl_general/tplot/xlim.pro 
idl/ssl_general/tplot/ylim.pro 
idl/ssl_general/tplot/zlim.pro 
 

xlim                       ; Set "TPLOT" limits using the cursor. 
ylim,'Ne',.01,100,1        ; Change limits of the "TPLOT" variable 'Ne'. 
zlim,'ehspec',1e-2,1e6,1   ; Change color limits of the "TPLOT" variable 'ehspec'. 
xlim,lim,-20,100           ; create a variable called lim that can be passed to a 
                           ; plotting routine such as "SPEC3D". 

 
 

tplot variables can be stored in files using tplot_save and loaded using tplot_restore. You can also retrieve data from tplot 
variables and manipulate it in IDL.  For example, if you run thm_part_getspec, specifying the /energy keyword, you can get 
the values corresponding to the center of each energy channel from the 'th*_en_eflux*' tplot variables that are created by 
using get_data: 
 
get_data, 'thc_pser_en_eflux', x, y, z 
print, z[0,*] 

 
You can find these codes at idl/ssl_general/tplot/get_data.pro and idl/ssl_general/tplot/store_data.pro 

5.5.3.2 Plotting with Plotxy 
Plotxy and plotxyz are routines that are designed to plot two dimensional projections of three dimensional vector data or cuts 
across a three dimensional space.  The ratio of lengths of the axes will be maintained so that relationships between the axes 
will not be distorted. Another way to say this is that they generate isotropic line plots.  Any possible projection can be 
specified by naming the two axes of the data that identify a plane or by providing a matrix whose columns define a generic 
plane. The plot will contain a projection of the data within the plane defined by the span of the axes or the span of the two 
columns of the matrix.  Plotxy is used to plot array data and tplotxy is used to plot tplot variables.   These routines are useful 
for plotting spacecraft position data and traces of magnetic field lines.   Plots that are generated by plotxy and plotxyz can be 
arranged in the same window together but there is no option that allows the placement of plotxy and tplot plots in the same 
window. Plotxy takes an array of vectors as an input. Tplotxy takes the name or names of tplot variables to be plotted as an 
input. 
 
Documentation that explains how to use these routines in detail can be found in the headers at the beginning of the procedure 
files, in the cribs, or by using the 'doc_library' command.  For example: doc_library,'plotxy' The plots generated by these 
routines can be exported in the same ways that tplot plots can be exported. 
 
The routines can be found at: 
idl/ssl_general/tplot/plotxy.pro 
idl/ssl_general/tplot/tplotxy.pro 
 
Cribs for the routines can be found at: 
idl/themis/examples/thm_crib_plotxy.pro 
idl/themis/examples/thm_crib_tplotxy.pro 
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The example below demonstrates how to plot the orbit of THEMIS C. 
 
;this sets the time range and loads the position data 
timespan,'2008-04-02' 
thm_load_state,probe='c d',coord='gse' 
 
;set up a window for the plots 
window,xsize=600,ysize=300 
 
;convert data from km to earth radii 
tkm2re,'th?_state_pos',/replace 
 
;this will set up a two plot panel one will contain the x vs y plot of the spacecraft orbit 
;the other will contain the  x vs z  plot of the spacecraft orbit.  The x axis will run from right to 
left on the second plot.  
 
tplotxy,'thc_state_pos thd_state_pos',multi='2 1',colors=[2,4] 
tplotxy,'thc_state_pos thd_state_pos',versus='xrz',/add,colors=[2,4] 

5.5.3.3 Plotting with Plotxyz 
 
Plotxyz is a routine that is designed to plot isotropic or non-timeseries spectrograms.  Generally, plotxyz is used in 
conjunction with bin2d to generate a two dimensional array that contains values that are a function of two other variables.  
For example, plotxyz can be used to generate a spectrogram of pressure vs. x-y position.  Many of the options for plotxyz and 
plotxy are the same, but there is no version plotxyz that works directly with tplot variables.  Plotxyz and plotxy plots can be 
arranged in the same window together, but there is no option that allows the arrangement of plotxyz plots in the same 
window as tplot plots.  Plotxyz requires three inputs, and accepts many different options keywords.  The first input is an M 
element one dimensional array that contains the values of the x axis. The second input is an N element one dimensional array 
that contains the values of the y axis.  The third input contains an MxN element two dimensional array that stores the z value 
of each combination of x and y.   
 
Documentation that explains how to use these routines in detail can be found in the headers at the beginning of the procedure 
files, in the cribs, or by using the 'doc_library' command.  For example: doc_library,'plotxyz' The plots generated by this 
routine can be exported in the same ways that tplot plots can be exported. 
 
The routines can be found at: 
idl/ssl_general/tplot/plotxyz.pro 
idl/ssl_general/misc/bin2d.pro 
 
The crib for the routines can be found at: 
idl/themis/examples/thm_crib_plotxyz.pro 
 
The example below shows how to generate a spectrogram of density versus position using plotxyz. 
 
;load the data and convert to RE 
timespan,'2008-02-14' 
 
thm_load_state,probe='a',coord='gsm' 
thm_load_mom,probe='a' 
 
tKm2Re,'tha_state_pos',/replace 
get_data,'tha_state_pos',data=d_pos 
 
get_data,'tha_peim_density',data=d_den 
 
;interpolate the data onto the same time grid 
den = interpol(d_den.y,d_den.x,d_pos.x) 
 
;bin the data using bin2d 
;the '$' in the command below shows IDL that this is a single command that is printed on two lines. 
;if you want you can remove the '$' and print the next two lines on a single line in IDL  
bin2d,d_pos.y[*,0],d_pos.y[*,1],den,binum=20,averages=averages,$ 
xcenters=x_centers,ycenters=y_centers,flagnodata=!values.d_nan 
 
;plot the spectrogram 
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plotxyz,x_centers,y_centers,averages,xtitle='X [RE GSM]',ytitle='Y [RE GSM]',/grid 
 

5.5.3.4 Plotting Angular Spectra 
 
Use thm_part_getspec.pro to produce angular and/or energy spectra of Themis particle data (SST/ESA) as a function of 
time.  In addition to specifying the time range of interest, the user can also choose to calculate spectra for one or more probes 
and data types.  Only a single type of angular spectra (i.e. phi, theta, pitch angle, gyrophase) may be created by a single 
execution of the code.  However, energy spectra may be created concurrently with angular spectra. Regardless of the type of 
spectra to be calculated, the ranges of phi, theta, pitch angle, gyrophase, and energy used to calculate the spectra can be set by 
the user.  Phi, theta, and energy ranges affect energy and phi/theta angular spectra.  Phi, theta, pitch angle, gyrophase and 
energy ranges affect pitch angle/gyrophase spectra. The code also has the ability to normalize the flux for each time sample in 
a spectra plot to values between 0 and 1.  By default, tplot variables containing angular spectra have tplot names containing 
“an_eflux” followed by the angular spectra type (e.g. phi, theta, pa, gyro), and energy spectra tplot names end with 
“en_eflux”. Typing doc_library, ‘thm_part_getspec’ at the command prompt will return a list of detailed keyword usage 
information.  See themis/examples/thm_crib_part_getspec.pro for an in-depth description of the code and examples of 
how to generate different types of plots.  Below is a simple example that will calculate iSST phi angular spectra for two 
probes, and automatically generate a plot using the /autoplot keyword. 
 
thm_part_getspec, probe=['a','e'], trange=['07-03-23/10:30','07-03-23/12'], $ 
                 phi=[0,360], theta=[-90,90], data_type=['psif'], angle='phi', /autoplot 
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5.5.3.5 Removing SST Contamination 
 

Sun contamination, electronic noise, and the on-board mask can be removed by passing various arguments to 
thm_part_getspec and thm_part_moments.  These operations may only be performed on ground data(not for on-board 
moments) and they only work on full or burst distribution data.    A crib describing the operations in detail can be found at:  
themis/examples/thm_crib_sst_contamination.pro 
 
thm_part_getspec can be used to generate angular plots with contamination removed.  
thm_part_moments can be used to generate moments(en_eflux,denstity,etc..) with contamination removed. 
 
  Both routines use the same set of  arguments to remove contamination.  Contamination is usually easier to see in angular 
plots and data at different times may require slightly different settings to effectively remove the contamination, so it is often 
useful to generate angular plots with thm_part_getspec to test that the contamination is being removed effectively before 
generating moments.  A basic description of the techniques used to remove the types of contamination is below: 
 
Sun Contamination: 
  The routine fills in all the data that is more than some statistical limit from the data.  The statistic that is used, the limit, and 
the method of filling can be set by the user.   Linear interpolation along phi has been found to be an effective method for 
filling and the standard deviation from the median is effective at identifying contamination.  A limit of 2.0 is the default. 
If the contamination isn't being removed, lowering the limit or changing the methods used can sometimes be helpful. 
 
On-Board-Masking: 
  The on-board mask is identified by finding the phi bin that has a 0 value for a given percentage of the time interval.  
Generally a value of 100% or 99% is very effective.  99% is often better because in some data sets that mask will not always 
be 0, due to errors in transmission.  The phi is then filled in using the user specified fill method.  Linear interpolation across 
phi generally works quite well. 
 
Electronic Noise: 
  Electronic noise is removed via a 2-step process.  First the user generates an angular plot of the contaminated data of 
interest.  They then use edit3dbins to examine the relative values of the contaminated bins during at a time when flux is 
nearest to 0 in all angles.  They select the bins that look contaminated during this time and pass the list of contaminated bins 
into thm_part_getspec or thm_part_moments along with the time interval of the low flux region.   The routines 
then subtract the values of selected bins during the low flux interval from those bins over the entire interval. 
 
5.5.3.6  Overlaying Spectrograms Using Tplot Pseudovariables 

 
Pseudovariables are a little known tplot feature that allows one or more tplot variables to be stored in a single tplot variable 
using the store_data command.  For example, 

 
store_data, 'pseudo_var', data=['tplot_var1','tplot_var2'] 
 

allows the user to plot the tplot variables tplot_var1 and tplot_var2 together in the same panel with the command: 
 
tplot, 'pseudo_var' 
 

One application of this feature is the merging of multiple spectrograms into a single plot.  For example, one can combine full 
and burst mode spectrograms into a single plot by overlaying the burst mode data on top of the full mode data.  Below is an 
example using ESA full and burst ion energy spectra: 

 
thm_part_getspec, probe=['a'], trange=['07-03-23/10:30','07-03-23/12:40'], $ 
                  theta=[-90,90], phi=[0,360], data_type=['peif','peib'], $ 
                  /energy, datagap=400 
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The datagap keyword is very important in this case.  It should be set to a number of seconds that is less than the time gap 
between burst data segments, but greater than the sample interval of the underlying full mode data.  This is necessary to 
prevent tplot from interpolating between the burst mode segments, thus allowing the underlying full mode data to be seen 
between the burst mode data segments. 

 
Now create a pseudovariable that stores the full and burst data in one tplot variable: 

 
store_data, 'tha_comb', data=['tha_peif_en_eflux','tha_peib_en_eflux'] 
 

The next step is to set the y-axis and z-axis limits of the pseudovariable.  This ensures that the full and burst mode data will 
have the same color and vertical scale.  

 
ylim,'tha_comb',5,23000 ; set y-axis limits 
zlim,'tha_comb',10,3e6 ; set all spectra to same color scale 

 5.5.4 Calibrations and Beyond 
 
Refer to the crib sheet for each instrument for usage of the calibration routines.  The interface to the various calibration 
routines has not yet been standardized. 
 
Calibration: from L1 data to physical quantities 
thm_cal_efi Calibrates Electric Fields Instrument 
thm_cal_fbk Calibrates Filter Bank 
thm_cal_fft Calibrates FFT data 
thm_cal_fgm Calibrates Flux gate magnetometer 
thm_cal_fit Calibrates spin fit data.. 
thm_cal_mom Calibrates all (ESA and SST) on-board moment data 
thm_cal_scm Calibrates SCM data 
 
For working with SST or ESA data and creating ground-processed moments, see the crib sheets. 

5.5.5 Geophysical Coordinate Transformations 
thm_cotrans can be used to transform a THEMIS vector data quantity stored in a tplot variable to any of the following 
coordinate systems: 
Abbreviation Description 
SPG Spinning Probe Geometric 
SSL Spinning SunSensor L-vectorZ 
DSL Despun SunSensor L-vectorZ 
GEI Geocentric Equatorial Inertal 
GSE Geocentric Solar Ecliptic 
GSM Geocentric Solar Magnetospheric 
SM Solar Magnetic 
For details and diagrams, see THM_SOC_110_COORDINATES. 
 
The default output of thm_load routines is DSL.  The thm_load routines set metadata in the tplot variable, which indicates the 
coordinate system of the data.  Thm_cotrans is aware of this metadata, so it is not necessary to specify an input coordinate 
system when calling thm_cotrans. 
thm_cotrans usage: 
 
;Procedure: thm_cotrans 
;Purpose:   Transform between various THEMIS  and geophysical coordinate systems 
;keywords: 
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;  probe = Probe name. The default is 'all', i.e., transform data for all 
;          available probes. 
;          This can be an array of strings, e.g., ['a', 'b'] or a 
;          single string delimited by spaces, e.g., 'a b' 
;  datatype = The type of data to be transformed, can take any of the values 
;          allowed for datatype for the various thm_load routines. You 
;          can use wildcards like ? and [lh]. 
;          'all' is not accepted. You can use '*', but you may get unexpected 
;          results if you are using suffixes. 
;  in_coord = 'spg', 'ssl', 'dsl', 'gse', 'gsm', or 'gei' 
;          coordinate system of input. 
;          This keyword is optional if the coord_sys attribute 
;          is present for the tplot variable, and if present, it must match 
;          the value of that attribute.  See cotrans_set_coord, cotrans_get_coord 
;  out_coord = 'spg', 'ssl', 'dsl', 'gse', 'gsm', or 'gei' 
;           coordinate system of output. 
;  in_suffix = optional suffix needed to generate the input data quantity name: 
;           'th'+probe+'_'datatype+in_suffix 
;  out_suffix = optional suffix to add to output data quantity name.  If 
;           in_suffix is present, then in_suffix will be replaced by out_suffix 
;           in the output data quantity name. 
; valid_names:return valid coordinate system names in named variables supplied to 
;           in_coord and/or out_coord keywords. 
;Optional Input Parameters: 
; in_name  Name(s) of input tplot variable(s) (or glob pattern) (space-separated string list or array of strings.) 
; out_name Name(s) of output tplot variable(s).  glob patterns not accepted. 
;          Number of output names must match number of input names (after glob 
;          expansion of input names).  (single string, or array of strings.) 
; 
; Example: 
; thm_cotrans, probe='a', datatype='fgl', out_coord='gsm', out_suffix='_gsm' 
Several examples of thm_cotrans usage can be found in thm_crib_fgm.pro. 
A low-level coordinate transformation routine is available if working with simple arrays rather than tplot variables is desired. 
cotrans  Transform between geophysical coordinate systems GSE, GEI, and GSM. 

 
5.5.6 Analytical  Coordinate Transformations 

5.5.6.1  Field Aligned Coordinate Transformations 
The TDAS distribution allows transformation of three dimensional vectors into magnetic field aligned coordinate systems. 
 
In order to rotate a vector into a field aligned coordinate system, a coordinate transformation matrix must first be generated 
using /themis/state/thm_fac_matrix_make.pro. This routine allows the generation of transformations for several different 
varieties of coordinate system.  The primary input to thm_fac_matrix_make is a tplot variable containing the magnetic field 
vector, which is typically generated by calling thm_load_fgm.pro.   Depending on the type of coordinate system variant 
requested, a tplot variable containing the position vector array (generated by calling thm_load_state.pro) may also need to 
be supplied via the pos_var_name keyword.  The Z axis of the resulting coordinate system (transformation) will always be in 
the direction of B field vector. The other_dim keyword determines the requested variant of the transformation by specifying 
the second axis for the field aligned coordinate system. The third dimension will always be the cross product of this Z axis 
and the other_dim axis.   Type doc_library, ‘thm_fac_matrix_make’ at the command prompt to see a description of the 
different other_dim options or look at the header at the top of the procedure file. 
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One caveat is that the magnetic field tplot variable must be in gse, gsm, or dsl coordinates, depending on what transformation 
has been selected. Another caveat is that the position tplot variable must be in gei coordinates, the default coordinate 
system of thm_load_state.  Also note that the resulting transformation matrices will only correctly transform data from the 
coordinate system of the input variable to the field aligned coordinate system.  So if mag_var_name is in DSL coordinates 
then you should only use the output matrices to transform other data in DSL coordinates. 
 
Once the transformation matrix has been generated, the vector can be rotated by calling 
/ssl_general/cotrans/special/tvector_rotate.pro with the transformation matrix as the first argument, and the tplot 
variable containing the vector to be rotated into the field aligned coordinate system as the second argument.  Below is an 
example: 
 
timespan, '2007-03-23' 
thm_load_state,probe='c', /get_support_data 
thm_load_fgm,probe = 'c', coord = 'dsl' 
  ;smooth the Bfield data appropriately 
tsmooth2, 'thc_fgs_dsl', 601, newname = 'thc_fgs_dsl_sm601' 
  ;make transformation matrix 
thm_fac_matrix_make, 'thc_fgs_dsl_sm601', other_dim='xgse', newname = 'thc_fgs_dsl_sm601_fac_mat' 
  ;transform Bfield vector (or any other) vector into field aligned coordinates 
tvector_rotate, 'thc_fgs_dsl_sm601_fac_mat', 'thc_fgs_dsl', newname = 'thc_fgs_facx' 

 
See themis/examples/thm_crib_fac.pro for more examples of how to rotate vectors into field aligned coordinates. 
 

5.5.6.2  Minimum Variance Transformations 
The TDAS distribution allows transformation of three dimensional vectors into a minimum variance  coordinate system 
defined by an interval or intervals from time series vectors. 
 
This transformation is performed in two steps.  First, transformation matrices must be generated from some input time series 
vector data.  Second, the transformation matrices must be used to transform time series vector data. These input data must be 
stored in tplot variables. 
 
The minimum variance coordinate system is defined by generating the covariance matrix for an interval of data.  This matrix 
is then diagonalized to identify the eigenvalues and eigenvectors of the covariance matrix. The eigenvector with the smallest 
eigenvalue will be the direction of the z component of the new coordinate system.  The eigenvector with the largest 
eigenvalue will be the direction of the x component of the new coordinate system.  The third eigenvector will be the y 
direction of the coordinate system. 
 
The user should note that the resulting transformation matrices will only correctly transform data from the coordinate system 
of the input variable to the minimum variance coordinate system.  So if the data used to define the coordinate system are in 
gse coordinates then you should only use the output matrices to transform other data that are in gse coordinates. 
 
The routine to generate the matrices can be found at: 
idl/ssl_general/cotrans/special/minvar/minvar_matrix_make.pro 
The routine to perform rotations using the minimum variance matrices can be found at: 
idl/ssl_general/cotrans/special/tvector_rotate.pro 
The cribs for these routines can be found at: 
idl/ssl_general/cotrans/special/minvar/mva_crib.pro 
idl/themis/examples/thm_crib_mva.pro 
 
Additional documentation can be found in the headers at the top of the procedure files listed above or by typing 'doc_library' 
from the idl command prompt.  For example: doc_library,'minvar_matrix_make' will show the documentation for 
'minvar_matrix_make'. 
 
The example below will use fluxgate magnetometer data to generate a minimum variance coordinate 
system and transform that data into the minimum variance coordinate system. 
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;this sets the time interval from which data should be loaded 
timespan,'2007-07-10/08:10:00',22,/minute 
;this loads the data 
thm_load_fgm,probe='c',coord='gse' 
 
;this generates the transformation matrices 
minvar_matrix_make,'thc_fgs_gse',tstart='2007-07-10/07:54:00',tstop='2007-07-10/07:56:30' 
 
;this transforms the data 
tvector_rotate,'thc_fgs_gse_mva_mat','thc_fgs_gse',newname='mva_data_day' 

 
;this sets the axis labels 
options,'mva_data_day',labels=['maxvar','midvar','minvar'] 
 
options,'mva_data_day',labflag=1 

 
;this plots the original data and the transformed data  
tplot,'thc_fgs_gse mva_data_day' 

 

5.5.7 Tsyganenko Model 

5.5.7.1  Introduction 
Version 4.0 of TDAS allows access to the Tsyganenko Fortran routines via a DLM interface written by Haje Korth.  Wrapper 
code has been provided in IDL to make use of the Tsyganenko model from IDL quick and easy, even for a user that is not 
familiar with the models.  Support has been provided for routines that provide the model B field at a user specified set of 
locations and for tracing field lines from a position to the ionosphere or the equator.  Routines are also available to ease the 
generation of model parameters from solar wind data.  The supported models are the t89,t96,t01 and t04s models. 

5.5.7.2  Installation 
To run the Tsyganenko routines you will need to install Haje Korth's IDL GEOPACK wrapper for Tsyganenko’s original 
Fortran code.  The current version of the IDL GEOPACK can be found at the THEMIS website at the following URL: 
http://themis.ssl.berkeley.edu/idl_geopack_all_67.zip . Please download this file and unzip it.   You then need to place two 
files in your idl dlm directory.  If you do not know what your dlm directory is you can type 'print,!DLM_PATH 
' from within idl. The first file is called 'idl_geopack.dlm'.  The second file will have a different name depending on your 
operating system.  For windows it will be called 'idl_geopack.dll 
'. On most other OS's it will be called 'idl_geopack.so'. This file will be found in a subdirectory of idl_geopack_all_67.zip 
that is named for your operating system.  After you copy these files two files into your idl dlm directory , all you need to do is 
restart idl.  If you want to test that the installation worked type 'print,igp_test()'.  If this prints out '1', it worked. 
 
These installation instructions can also be found in the software distribution itself in 
idl/external/IDL_GEOPACK/README.txt 

5.5.7.3  Model Routines 
Routines to generate the model field vectors for time series of position vectors can be found in the 
idl/external/IDL_GEOPACK directory and its subdirectories.  These routines take either tplot variables or arrays of times and 
positions as arguments.  They will produce the model magnetic field.  Extensive documentation and examples can be found 
in the cribs and in the headers at the tops of the files.  
 
One caveat is that you should remember to set the period keyword equal to a number of seconds equal to the cadence of your 
data to prevent the result vectors from sawtoothing when the geomagnetic dipole is recalculated. If your position data is all at 
a single time do not worry about the period argument. 
 
The cribs for the routines are: 
  idl/external/IDL_GEOPACK/t89/tt89_crib.pro 
  idl/external/IDL_GEOPACK/t96/tt96_crib.pro 
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  idl/external/IDL_GEOPACK/t01/tt01_crib.pro 
  idl/external/IDL_GEOPACK/t04s/tt04s_crib.pro 
 
The tplot based routines are: 
  idl/external/IDL_GEOPACK/t89/tt89.pro 
  idl/external/IDL_GEOPACK/t96/tt96.pro 
  idl/external/IDL_GEOPACK/t01/tt01.pro 
  idl/external/IDL_GEOPACK/t04s/tt04s.pro 
 
The array based routines are: 
  idl/external/IDL_GEOPACK/t89/t89.pro 
  idl/external/IDL_GEOPACK/t96/t96.pro 
  idl/external/IDL_GEOPACK/t01/t01.pro 
  idl/external/IDL_GEOPACK/t04s/t04s.pro 
 
The routine that generates model parameters from solar wind data for the t96,t01, and t04s models is: 
 idl/external/IDL_GEOPACK/get_tsy_params.pro 
 
Here is a simple example: 
 
timespan,'2007-03-23' 
thm_load_state,probe='b',coord='gsm' 
tt89,'thb_state_pos',kp=2,period=60 
tplot,'thb_state_pos_bt89'  

5.5.7.4  Trace Routines 
 
Routines to trace field lines from specified positions can be found in the idl/external/IDL_GEOPACK/trace/ directory.  The 
routines will use numerical techniques for solving differential equations to trace the magnetic field lines from a set of 
specified positions to either the equator or the ionosphere. These routines take as arguments either tplot variables storing 
three dimensional position data or arrays of vectors and times. They will produce footprints of the field lines on the 
ionosphere or equator. Full traces of the entire field lines can be returned if requested as well.  Plotting of traces can often 
best be performed with the plotxy or tplotxy plotting routines.  The trace routines can trace using any of the four supported 
Tsyganenko models.   The trace routines work equally well if all positions use the same time and are often used to look at 
field lines traced from several positions at a single instant.  More extensive documentation and examples can be found in the 
headers at the top of files and in the crib. 

 
These routines come with two caveats: 
1. As with the model routines, if your data is not all at a single time the period keyword should be set to the cadence of your 
data to prevent inaccuracies from geomagnetic dipole recalculations. 
2. Solving differential equations can take a long time, so please be patient.    Sometimes the field lines will continue away 
from the earth an infinite distance or even fall into an infinite loop condition due to the insolubility of the system.   The latter 
case only occurs rarely.  To avoid the former case the R0 and RLIM parameters can be used to set maximum and minimum 
distance cutoffs at which to stop tracing. 
 
An extensive crib for these routines can be found at: 
idl/external/IDL_GEOPACK/trace/ttrace_crib.pro 
 
The tplot based routines can be found at: 
idl/external/IDL_GEOPACK/trace/ttrace2equator.pro 
idl/external/IDL_GEOPACK/trace/ ttrace2iono.pro 
 
The array based routines can be found at: 
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idl/external/IDL_GEOPACK/trace/trace2equator.pro 
idl/external/IDL_GEOPACK/trace/trace2iono.pro 
 
The trace routines can also use the get_tsy_params routine to generate model parameters. It is at: 
idl/external/IDL_GEOPACK/get_tsy_params.pro 
 
Here is a simple example: 
timespan,'2007-03-23' 
 
thm_load_state,probe='b',coord='gsm' 
 
ttrace2iono,'thb_state_pos',external_model='t89',par=2.0D,/km 
,period=60 
tplotxy,'thb_state_pos_foot' 

 

5.5.8 Mini Language 
 
A simple scripting language for working with tplot variables has been provided in a form that is usable at the command line 
and from within the THEMIS GUI.   At the command line you can access this language using the 'calc' command.  From 
within the GUI you can access this language by selecting “Analysis->Calculate...” from the main GUI window.    
 
Here is an example of a mini language call from the command line: 
calc,'”tha_state_pos_avg” = mean(“tha_state_pos”,2)' 
 
In the GUI this statement would simply be: 
 
”tha_state_pos_avg” = mean(“tha_state_pos”,2) 
 
In both cases the command takes the average of each x,y,z triplet and stores the output in a new tplot variable that has 
dimensions time by 1 rather than time by 3(x,y,z).   Inside the gui the outer set of single quotation marks is not required. 
 
Examples of command line usage can be found in the file: 
themis/examples/thm_crib_calc.pro 
 
In all subsequent examples, the 'calc' command will be omitted for brevity. 
 
Data Types: 
 
There are three basic data types in the mini language: 
1. Numerical constants. 
These are terms like: 
1,1B,1.2,-2.3e-4 
The mini language accepts numerical constants of any type that IDL accepts with the exception of complex numbers 
 
2.  Normal variables 
These are terms like: 
a,b,hello, world 
These can be read out of the current IDL session or defined by a mini-language statement.  Their only major restriction is that 
when they are used in the GUI they are only in scope for the duration of a mini-language program. 
 
3. Tplot/Gui variables. 
These are terms like: 
“tha_state_pos”, “thb_fgs_dsl”,”thc_peif_en_eflux” 
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These are settings, time, and data bound together into a single name.  Most of the data in the GUI and from Themis will be 
represented in this form.  To differentiate these variables from normal variables, they are always denoted with quotes(“ “).   
When tplot/gui variables are used in expressions their times and other settings are carried along into the output if the output is 
also a tplot/gui type. 
 
Operations between Normal Variables and Tplot/GUI variables, are required to have matching numbers of elements and 
matching dimensions to work. 
 
Syntax: 
 
Statements in the mini language have one of two basic forms. 
 
1. Basic Assignments: 
These are statements like: 
a = 6374.4 

“thb_state_pos_re” = “tha_state_pos” / a 

state_var = “tha_state_pos” 

 
The left hand side can be a normal variable or a tplot/gui variable.  The right hand side can contain and combination of 
numerical constants, normal variables, tplot/gui variables, operators, and functions. 
 
2. Compound Assignment/Operations: 
These are statements like: 
“tha_state_pos” /= 6374.4 

 
These have the same form as basic assignments but allow the user to write statements in a more concise form.( the statement 
above is equivalent to: 
 “tha_state_pos” = “tha_state_pos” / 6374.4 

 

Operators: 
 
Operators can be used to combine any of the data types on the right hand of the equation.  The only practical limitation on the 
number of operators and data types that can be combined in a single expression is the amount of available memory.  These 
operators follow the same operator precedence as IDL.  Like many languages,  the operator precedence can be overridden 
using parentheses.  The allowable operators are: 
~  : logical negation (c = ~a) 
++ : increment (c = a++) or (c = ++a) 

-- : decrement (c = a--) or (c = --a) 

-  : subtraction (ex: c = b-a) 

+  : addition (ex: c = b+a) 

*  : multiplication (ex: c = b*a) 

/  : division (ex: c = b/a) 

^  : exponentiation ( ex: c = b^a) 

<  : array less-than (ex: c = b < a) 

>  : array greater-than ( ex: c = b > a) 

&& : logical conjunction ( ex: c = a && b) 

|| : logical disjunction ( ex: c = a || b) 

#  : row-major matrix multiplication ( ex: c = a # b) 

## : column-major(traditional) matrix multiplication ( ex: c = a ## b) 
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mod : modulus operator (ex: c = a mod b) 

and : binary conjunction (ex: c = a and b) 

eq  : logical equivalence (ex: c = a eq b) 

ge : logical greater-than-or-equal-to (ex: c = a ge b) 

gt : logical greater-than (ex: c = a gt b) 

le : logical less-than-or-equal-to (ex: c = a le b) 

lt : logical less-than (ex: c = a lt b) 

or : binary disjunction ( ex: c = a or b) 

xor : binary xor (ex: c = a xor b) 

() : precedence override ( ex: d = (a + b) * c) 

 
Note that any of these operators can be combined with an '=' to create a compound operator/assignment statement in the mini 
language.   
 
Also users on the command line can obtain a list of the available operators using the following statement: 
calc,operator_list=op 

print,op 

 

Functions: 
 
The mini language supports a variety of different functions, but it does not maintain the function/procedure distinction that 
IDL does.  All routines must be function calls.  All routines are built in.  There are no user-defined function calls.  All 
functions have one required argument which can be an element of any data type.  Some routines also accept a second optional 
argument.  The optional argument is always a number.   Functions and operations can be combined together in the same ways 
that a normal programming language would combine them. Example: 
 

“tha_state_pos_log” = log(“tha_state_pos”+10) / 6374.4 

 
The list of available functions follows: 
 
log(x[,base]) : By default, returns a base 10 logarithm on the input. 

                If [,base] is provided, this function will perform the logarithm 

                using the provided base. Example: 

                “tha_peif_en_eflux_log” = log(“tha_peif_en_eflux_log”,2) 

 

ln(x)         : Returns a natural logarithm of the input. 

exp(x[,base]) : By default returns e^x, where e is the natural base.  If [,base] 

                is provided, it will return base^x. 

sqrt(x)       : Returns the square root of the input. 

abs(x)        : Returns the absolute value of the input. 

sin(x)        : Returns the sine of the input. 

arcsin(x)     : Returns the inverse sine of the input. 

sinh(x)       : Returns the hyperbolic sine of the input. 

cos(x)        : Returns the cosine of the input. 

arccos(x)     : Returns the inverse cosine of the input. 

cosh(x)       : Returns the hyperbolic cosine of the input. 

tan(x)        : Returns the tangent of the input. 

arctan(x)     : Returns the inverse tangent of the input. 
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tanh(x)       : Returns the hyperbolic tangent of the input. 

csc(x)        : Returns the cosecant of the input. 

arccsc(x)     : Returns the inverse cosecant of the input. 

csch(x)       : Returns the hyperbolic cosecant of the input. 

sec(x)        : Returns the secant of the input. 

arcsec(x)     : Returns the inverse secant of the input. 

sech(x)       : Returns the hyperbolic secant of the input. 

cot(x)        : Returns the cotangent of the input. 

arccot(x)     : Returns the inverse cotangent of the input. 

coth(x)       : Returns the hyperbolic cotangent of the input. 

min(x[,dim])  : By default returns the single minimum for the entire input. 

                If [,dim] is provided function will perform the minimum across a  

                particular dimension of the input.  A one dimensional array will 

                be returned. Typically min(x,1) will perform a minimum across 

                time. min(x,2) will perform a minimum across x,y,z, etc... 

max(x[,dim])  : By default returns the single maximum for the entire input. 

                If [,dim] is provided function will perform the maximum across a  

                particular dimension of the input. 

mean(x[,dim]) : By default returns the single mean for the entire input. 

                If [,dim] is provided function will perform the mean across a  

                particular dimension of the input. 

median(x[,dim]) : By default returns the single median for the entire input. 

                If [,dim] is provided function will perform the median across a  

                particular dimension of the input. 

count(x[,dim]) : By default this function returns the count of the number of 

                 elements in the input. If [,dim] is provided this function will 

                 count the elements in each particular dimension of the input and 

                 return a result with multiple elements. 

total(x[,dim]) : By default this function returns the total of the elements in 

                 the input. If [,dim] is provided this function will total the 

                 elements in each particular dimension of the input and return a 

                 result with multiple elements. 

 
On the command line, you can use the following command to obtain a list of available functions: 
calc,function_list=f 

print,f 

 

Error handling: 
 
When using the GUI any errors will be reported in a popup message and in the status bar at the bottom.  On the command 
line errors are returned through the 'error' keyword.  For example: 
 
THEMIS> calc,'illegal statement',error=e 

THEMIS> help,e,/str 

** Structure <89b945c>, 4 tags, length=68, data length=68, refs=1: 

   TYPE            STRING    'error' 

   NAME            STRING    'User statement syntax error' 
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   STATE           LONG                 3 

   TOKEN           STRUCT    -> <Anonymous> Array[1] 

 
The returned statement contains the name of the error type and also returns information about the state of the interpreter that 
can be useful in helping THEMIS programmers diagnose and fix the error.  

5.5.9 Data Export 
You can export your data and/or plots to a variety of data formats. 
Examples (please read procedure headers for additional options and information): 
 
Export to ASCII files: 
This example writes out Flux Gate Magnetometer Slow Survey data for all probes. 
The ext keyword is being used to add the time of the data to the filename. 
The dir keyword is being used to set the directory to which the files will be written. 
 
tplot_ascii, 'th?_fgs', trange=timerange(/current), dir='~/thm/waves', ext='_20070520.txt' 

 
Export to PNG: 
This example writes a png of the plot displayed by the given tplot command. 
 
tplot,'th?_fgs' ;plots the data 
makepng, '~/thm/waves' ;make a png  file called  ~/thm/waves.png 

 
Export to Postscript: 
This example writes a postscript by recreating the previously generated plot. 
 
tplot, ‘th?_fgs'     ;setup the plot however you want it 
popen,'~/thm/waves'  ;start a ps called waves.ps 
tplot                ;call with no arguments to replot previous plot 
pclose               ;finalize postscript and save it 

 
Export to Encapsulated Postscript(EPS): 
This example writes an encapsulated postscript by recreating the previously generated plot. 
 
tplot, 'th?_fgs'                   ;setup the plot however you want it 
popen, '~/thm/waves', /encapsulated ;start an eps called waves.eps 
tplot                             ;call with no arguments to replot previous plot 
pclose                            ;finalize eps and save it 

5.5.10 Configuring Local Data Cache and Remote Access Behavior 
Data locations may be configured at IDL startup (for example, if you want the data to reside in a non-standard location), or 
dynamically during an IDL session. 
 
The following table summarizes the controls that can be used, in order of precedence: 

• !THEMIS system variable 
• thm_config.txt (editable with and IDL program: thm_ui_config) 
• environment variable settings 
 

The following table summarizes the settings available: 
!themis structure 
element  

Environment Variable  Description 
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local_data_dir THEMIS_DATA_DIR a writable, local directory in which to 
cache data files. The default on 
Unix/Linux/Mac is ‘/disks/data/themis’. 
On windows, the default is 
‘C:\data\themis’ 

remote_data_dir THEMIS_REMOTE_DATA_DIR URL to a data archive where THEMIS 
data can be found. By default, 
http://themis.ssl.berkeley.edu/data/themis 

no_download N/A 1: don’t access remote_data_dir 
no_update N/A 0: download only if file on server differs 

or if local file does not exist. 
1: download only if local file does not 
exist. i.e. no clobber. 

Verbose N/A level of verbosity for themis commands, 
0=silent.  Values >1 are generally for 
debugging. 

5.5.10.1 Configuration at startup  
If you want to change the local_data_dir where data will be stored, run thm_ui_config at the IDL prompt. 
Change the setting for Local Data Directory and press ‘Save’; this will save the configuration to be used in all future IDL 
sessions.  The configuration is saved in a thm_config.txt file in an OS-specific location. Note that this operation only changes 
the Local Data Directory for THEMIS data. It does not change the ROOT_DATA_DIR variable defined in section 5.5.11. A 
more detailed description of the thm_ui_config widget is given in section 6.1.12. 

5.5.10.2 On-the-Fly configuration 
The local data directory location can be changed on-the-fly by setting the !themis.local_data_dir system variable.  For 
example, when you are on a PC connected to the SSL network, you may choose to use a networked data dir: 
!themis.local_data_dir = ‘\\justice\data\themis\’ 
 

The remote_data_dir structure element can also be updated to a different URL. 
 
If you want the software to use only locally available data, and don’t want the software to try to download data, you can set: 
!themis.no_download = 1 

 
Note that you can only set the !themis variable in an IDL session after a thm_ command has already been run, or after 
explicitly calling thm_init. Using thm_ui_config from the IDL prompt without pressing ‘Save’ in the widget is an alternate 
way of setting  !themis for the current IDL session. 
  

5.5.10.3 Note for users who connect using a web proxy server 
If you are behind a firewall and have to access the net through a  Web proxy,  set the environment variable 'http_proxy' to 
point to  your proxy server and port, e.g. (for Unix)  'setenv http_proxy=http://web-proxy-server.my_institution.edu:3128' 
The URL *MUST* begin with “http://". 
 
This can be done in your IDL_startup file, e.g.  IDL > setenv, 'http_proxy= http://web-proxy-server.my_institution.edu:3128’ 

5.5.11 Managing Your Data Cache 
There currently exist two experimental routines for managing your THEMIS data file cache.  These routines serve as an 
example of how you will be able to download all data for a given time range with a single command. 

• thm_file_download – can be used to download all types of THEMIS data for a given time span. 
• thm_file_cleanup – delete empty directories.  This is a function call.  It searches the hierarchy and return files 

matching a given pattern, sorted by access time.   This will only delete files if the “delete files” keyword is set. 
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5.5.12  Define the root_data_dir for ancillary (non-themis) data 
To define the root data directory for ancillary (non-themis) data (e.g.,  wind, ace, goes), which can also be accessed and 
manipulated by TDAS software, the default can be changed by setting an environment variable "ROOT_DATA_DIR". 
 
For example the following line can be put in the IDL_STARTUP file: 
setenv,'ROOT_DATA_DIR=/mydatacache/'   
or an equivalent setting made in the shell. The default for ROOT_DATA_DIR is ‘/disks/data’ on Unix/Linux/Mac and 
‘C:\data’ for Windows. It is important to note that the default THEMIS data directory will then be 
ROOT_DATA_DIR/themis/. This value can be changed using the methods described in section 5.5.9. 
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5.6 Software Organization 
 
The themis directory contains THEMIS-specific routines.  The general directory (currently named ssl_general) contains 
routines which are useful for more than one space-science mission for which THEMIS team members are developing code.  
The external directory contains packages developed and maintained by other groups, but which are required for writing (and 
running) some of the themis and/or general routines.   
 
The idl directory of the distribution includes the following files and sub-directories. 
  
_tdas_doc.html Documentation in  HTML format, including alphabetical list of all routines. 

setup_themis Sample setup script for csh (UNIX) 
ground/ routines for loading, processing and plotting ground-based data.  e.g. 

thm_load_gmag, thm_gmag_stackplot, imageplot, mosaicplot 
fields
/ 

routines for loading, processing and plotting particles data, e.g. 
thm_proc_fgm 

spacecraft/ 

partic
les/ 

routines for loading, processing and plotting particles data, e.g. 
thm_load_sst, thm_cal_sst 

state/ Routines for reading state and performing coordinate transformations, e.g. 
thm_load_state, thm_cotrans. 

examples/ Crib sheets, like thm_crib_ask 

themis/ 

common/ THEMIS-specific tools useful to multiple data types and instruments, eg 
thm_gui, thm_file_download, thm_init 

CDF/ CDF utilities, including cdf2tplot, and other utilities like cdf2tplot, 
cdf_info, cdf_load_vars (into IDL structure representation of CDF)  

science/ Routines useful for specific scientific analysis. 
cotrans/ General coordinate transformation: cotrans, ssl2dsl, dsl2gse 
tplot/ General time-plotting utilities 
misc/,  tools/ Miscellaneous routines used by tplot and other ssl_general routines. 
key_param/ Load routines for ACE, KP, WIND, POLAR data, some of these  

ssl_general/ 
 
 

missions/ Load routines for ACE, KP, WIND, POLAR data. Some of these replace 
older routines in the /key_param directory. 

external/ CDAWeb CDAWeb are CDF routines distributed by NASA’s SPDF. 
 IDL_GEOPACK Magnetic field modeling, Tsyganenko models 

 
The _tdas_doc.html file contains a complete listing of all routines in the hierarchy, along with links to complete 
documentation. 
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6 Graphical User Interface 
 
The THEMIS Graphical User Interface (GUI) provides a powerful interface to THEMIS science data. It is designed for ease 
of use in viewing and analyzing data and is set in a familiar windows-like environment. Features include the ability read, 
load, and view data, create publishing quality plots, access commonly used THEMIS analysis software, and increased user 
interaction. 
 
The GUI code is bundled together with the THEMIS IDL code distribution; they are downloaded and installed as a single 
package. 
 
A text-only version of the documentation for the GUI is available within the software distribution at 
idl/themis/examples/thm_gui.txt. 
 

6.1  Main Window Overview 
 
The main GUI window is shown below in Figure 6.1. This is a snapshot of the window when the GUI is first started. Since 
no data or THEMIS GUI document has been loaded and no plots created, the main graph area will be blank. 
 
Starting from the top of the window is the windows frame titled. THEMIS: Main Window. It has the standard window 
features in the frame to minimize, maximize, and close the window. 
 
Below the frame is the main menu bar. Commonly used menus include File, Edit, View, Page, and Help. Specific to the 
THEMIS application are Graph and Analysis pull down menus. 
 
Next, below the main menu bar is the toolbar. For quick and easy access to the most frequently used functions, the toolbar 
contains icon buttons the user can click on versus navigating through the pull down menu hierarchy.  All icon buttons in the 
toolbar contain tooltips to provide the user with a brief description of the functionality.  
 
The large central area of the main window contains the graph area and is where plots are displayed. To the right of the graph 
area is a scroll bar that allows the user to scroll vertically when multiple plots are displayed. 
 
And, finally, at the bottom of the window is a message bar. The message bar updates the user on the state of the GUI, the 
status of an operation, and provides general information to the user, including warning and/or error messages. 
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6.1.1 Pull Down Menus  
 
Pull down menus use standard features that users are familiar with and including the following: 
 
Sensitive:  A menu item may be sensitized or desensitized (grayed out) depending on the state of the GUI and/or the 
availability of an operation at the time it is requested.  
 
Checked:  Check marked menu items are used when an option can be turned on or off. The check mark allows the user to 
toggle on or off an item.  
 
Sub:  In cases where multiple options are available, a sub menu is used to further divide the functionality.  Submenus will 
have a carrot or arrow head indicating there are additional options to select from. 
 
Dynamic:  One menu, the Page menu, is not static and changes with the number of pages that have been created.  
 
Pop-Up:  In cases where a menu item displays another window, the name of the item will be following by three periods.   
 
Accelerator:  Some menus have accelerator keys associated with them. Accelerator keys provide a quick and easy way to 
invoke functions. When a menu item has an accelerator key, the key combination will be listed next to the name of the menu 
item.  
 
An example pull down menu is shown below in Figure 6.1.1.  
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6.1.2 Toolbar icons 
 
The tool bar provides short cuts to more commonly used functions. The buttons contain familiar icons depicting the 
operation. In addition, each tool bar button contains a tool tip that is displayed when the cursor hovers over the button. The 
tool tip displays text describing the function of the button. Buttons are clustered when their functionality is similar. Figure 
6.1.2 shows a picture of the tool bar.  
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6.1.3 Graph Area 
 
Shown below, in Figure 6.1.3, is an example of the main graph area with a graph plotted.  
 

 

 
 

6.1.4 Status Bar 
 
The status bar is located below the main graph area and displays messages to the user. Messages include status updates, state 
of the GUI and/or operation, success and failure notices, as well as warning and error information. It is important for the user 
to remember to check the status bar periodically for messages, particularly if you think something is not correct.  Information 
displayed in this bar may be helpful and provide an answer to your question.  
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Please note, when a severe error or incorrect usage occur you will be notified via a pop-up dialog window explaining the 
error.  Additional instructions may be provided.  
 

2.1.1 6.1.5 Buttons 
 
In order to provide a consistent interface throughout the GUI, you will find most windows contain the set of buttons shown in 
Figure 6.1.5.  
 
 

 
 
OK: When this button is clicked whatever changes you made since the window was first displayed will be made, committed 
within the system. The window will be closed and the main graph area will be updated to reflect the changes. Please note that 
when OK is selected the original settings will be lost. 
 
Apply: The apply button will update the main graph area so that you can view your changes. The window will not be closed 
and your changes will not be committed. 
 
Cancel: Whenever the cancel button is clicked all changes made since the window was first invoked will be reset to original 
settings. The window will be closed. The main graph area will be updated to reflect it’s original state. You should note that 
like the OK button, when the cancel button is selected all changes are lost permanently.  
 

6.1.6 Windows 
 
A window within the GUI refers to any windows that is opened when pull down selections are made, a tool bar button is 
clicked and other user interactions. Windows have frames, titles, and minimize, maximize, and close buttons within the 
frame. Most windows are also modal. That is, the user must either click the OK or Close button, or the Cancel button ‘X’ in 
the window frame before control is returned to the calling or original window.  

6.1.7 Pages 
 
The user can have one or many pages during a session. A page contains one or many panels, titles, background color, etc. 
The number of pages that have been created can be determined by using the Page pull down menu. The Page pull 
down menu also provides a way for the user to toggle between pages since only one page can be 
displayed at a time. 
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6.1.8 Panels 
 
A panel is a plot or graph on a page. Panels are usually contained within an axis frame and have x and y axes (and z axes for 
spectral data), traces, ticks, gridlines, and other features. One or many panels can be created per page.  
 

6.2.9 Color Palette 
 
Most of the Graph Options windows allow the user to change the color of labels, traces, background, grid, annotations, and 
more. Whenever color can be modified, a Color Button (with a color palette icon) and Color Swatch with the current color 
setting will be available. An example of the Color Button and Current Color Swatch and shown in Figure 6.1.9a.  
 

 
 

When the color button is clicked a Color Palette window is displayed.  The user can select a color by clicking on the color 
tiles or by using the RGB slider bars below the tiles. When a selection has been made the current color swatch in the middle 
of the window will be updated to reflect the new color. You can choose to accept the color by clicking on the Accept Button 
or choose not to make any changes by clicking on the Cancel Button. Both the Cancel and Accept buttons will close the color 
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palette window and return to the original or calling window. If the user accepted the color, the current color swatch in the 
original window will be updated. The color palette window is shown in Figure 6.1.9b.  
 

 
 

The Color Palette window is a modal window, that is, you must either make a selection or cancel the window in order to 
return control to the calling window.  
 

6.2.9 Data Tree 
 
All data that have been loaded directly into the GUI or imported from tplot variables are displayed in a tree widget. Many of 
the GUI windows require the user to select data for analysis or plotting and will be displayed in tree format. The tree widget 
allows the user to expand or collapse the tree by clicking on the ‘+’  (expand) or ‘-‘ (collapse) buttons next to the data. The 
data tree hierarchy is as follows: 
 

Mission 
Probe 
Instrument 
Data Set  
Data Components 

 
An example of a data tree is shown below in Figure 6.2.9.  



 
 
 
 

 

NAS5-02099 File: THEMIS_Science_Data_Analysis_Software_Users_Guide   69  

 
 

6.2 Mouse and Keyboard Events 

6.2.1 Tracking 
 
When tracking is enabled any movement within the frame of a panel in the draw area will be tracked with a vertical line. 
Tracking can be toggled on and off from the Graph pull down menu. In addition, the user can choose to track one panel or all 
panels. When the GUI session is first started, tracking of all panels is on by default. Figure 6.2.1 shows an example of the 
main graph area when tracking is turned on and tracking all panels. 
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6.2.1 Legend 
 
When tracking is on a legend will be appear in the upper right corner of each panel that is being tracked. The values of each 
data point intersecting the vertical tracking line are displayed. See Figure 6.2.1 above. The user can choose to turn the 
position legend on or off by toggling the Position Legend under the View menu. The legend is on by default.  If only one 
panel is being tracked, then only one panel will have a legend. Please note that if you have the position legend on and choose 
the print option, the legend will not appear in the plot so that the user can view the entire panel. 

6.2.3 Mouse Clicks 
 
The mouse button offers several ways to interact with the GUI and the graph area. Mouse clicks include Single Click (left 
button), Right Click, Ctrl-Click-Drag, and Click-Drag. 
 
Single Click: 
There are two possible events that a single click will generate. One is when marker(s) are present and the user clicks within 
the highlighted area of a marker, the other is when the user clicks outside of a marker but within the graph area. Markers will 
be explained shortly in Section 6.2.6. For now, we will describe a single click in the graph area, which brings up a graph 
options menu window. Which graph options window is displayed depends on where within the graph area the mouse button 
was depressed.  
 
There are 5 options. 
 

Page: Any area that is outside of a panel, axis, label, or variable display will bring up the Page Options Window. In 
the event the GUI cannot determine which object was clicked, the Page Options Window will be opened. 
Panel: When the user clicks within the frame of any panel, the Panel Options window is displayed 
X-Axis: When the user clicks on the X Axis the Axis Options panel is displayed. 
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Y-Axis: When the user clicks on the X Axis the Axis Options panel is displayed. 
Variables: If variables are present the user can click in the variable display area to open the Variable Options 
window. 

 

 
 
Please note that resolution and screen size vary between machines and platforms. If you click close to another object and do 
not get the options window you wanted, try clicking more in the middle of the area you want. 
 
Right Click: 
Clicking the right mouse button will bring up a context menu containing the most commonly used options associated with 
plotting and data analysis.  The context menu contains the following menu items. 
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6.2.4 Keyboard Events 
 
There are two kinds of keyboard events, scrolling and expanding/reducing.   
 
Scroll: The user can scroll the panels in the active page forward or backward by using the left and right arrow keys. The plot 
will be moved forward or backward in time by one major tick length. 
 
Reduce/Expand: The panels can also be reduced or expanded by using Ctrl-Backspace of Ctrl-Tab keys. Ctrl-Tab will expand 
the panels horizontally by two major tick lengths (one major tick length is added to both the left and right sides of the x axis). 
Similarly, Ctrl-Backspace will reduce the panels displayed by two major tick lengths. 
 

6.2.5 Markers 
 
Marking is a new feature that allows the user to mark or select regions of interest in panels on the active page. If tracking is 
set for all panels then all panels will be marked. Likewise, if only one panel tracking is set, then only the panel the cursor is in 
is marked. Marker ranges are selected horizontally or along the x-axis, using the vertical tracking line as the boundary.  The 
y-axis range is preserved.  
 
A Ctrl-Click-Drag operation is used to create a marker. To do this, hold the Ctrl key while depressing the mouse button and 
dragging the mouse. The user can click the mouse button or the Ctrl key in any order, marking will not start until the Ctrtl 
key is pressed and cursor movement is detected. Marking ends when the user releases the mouse button.  When you are 
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finished, the marked area will be highlighted.  Figure 6.2.5 shows examples of two markers, one created while all panels 
were being tracked, the other with only one panel tracking.  
 

 
 
There are several things worth noting about the marked regions shown in Figure 6.2.5. First, note that all three markers have 
boundary lines drawn in different colors. The current state of the marker is color coded.  
 
Green: Indicates that the cursor is currently within the marker 
Blue: Indicates the user has clicked the mouse button within that marker to make it ‘Active’ or the currently selected marker. 
Only one marker can be active at a time. 
Red: Represents all other markers (not active or the cursor is not within its area. 
 
When a marker is ‘active’ (blue boundary lines) there are additional functions you can perform on the marker. You can 
choose to delete the marker or zoom into the marked area.  
 
To delete a marker select the Delete Marker option under the Edit pull down menu. 
 
To display only the marked area, select the Subset option under the Edit pull down menu. A new page will be created and 
displayed containing only the marked area. The original page is preserved. You can use the Page pull down menu to see your 
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new page name and to move between pages or back to the original page. Marked areas are preserved and will not be lost 
when navigating between pages. 

6.2.6 Data Zoom 
 
Besides zooming in on marked areas, the user can also click and drag the mouse to zoom into a selected area. While markers 
preserve the y axis range, the click and drag does not.  
 
To zoom into an area depress the mouse button and drag the cursor. You will note that as you move the cursor and 
rectangular area is drawn on the panels. A corner of the rectangle is pinned as soon as you press the mouse button and cursor 
motion is detected. This rectangle is referred to as a rubber band box and can be moved in any direction. Figure 6.2.6a shows 
an example of a selected area. 

 

 
 
Once you are happy with the area you have selected you can release the mouse button. When the mouse button is released a 
new page will be created and the panel(s) redrawn with the x and y ranges contained in the rectangular area. Panels not 
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contained in the rectangle will not be redrawn. Similar to the Subset Marker option, the original page prior to the zoom 
operation is preserved. The Page pull down menu on the main GUI allows you to toggle between the two pages.  Figure 
6.2.6b shows the new page that was zoomed into.  
 
 

 

6.2.7 Page Zoom In/Out 
 
In addition to zooming into marked regions and/or rectangular areas the user can also choose to modify the page size by 
using the zoom spinner widget on the toolbar. The zoom spinner allows the user to increase or decrease page size by entering 
a percent value of the original page size.  Figure 6.2.7 shows an example of decreasing the page size by 50%. 
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6.3 File Menu 
 
The file menu contains selections that are related to loading, saving, and managing data, as well as printing and exporting 
image files. Figure 6.3 shows all options in the File pull down menu. 
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6.3.1 Open THEMIS Document 
 
The THEMIS GUI now includes the capability to (partially) save the state of a GUI session to a file we'll refer to as a 
"THEMIS GUI Document" (with default file extension of TGD). TGD files are plain ASCII text, use XML to represent 
properties of GUI objects and loaded data, and can be examined with any ASCII file editor.  Many web browsers also include 
support for viewing XML documents (although one may need to change the file extension to XML to get the browser to 
recognize the format).  
 
As of TDAS release 5.00, any loaded data associated with a GUI session is NOT directly stored in the TGD file; instead, the 
document contains the information necessary to reconstruct the sequence of calls that were initially used to load the data.  
There are some pros and cons to this approach that users should be aware of: 
 

1) TGD files are relatively small, and can be easily shared as email attachments.  Because they are plain ASCII text, 
there are no significant file format differences between different platforms, so TGD files are portable between 
systems. 

2) Opening a TGD file may require internet connections to THEMIS data servers in order to download any data files 
that are not already cached in the user's local file system. 

3) Since the TGD file only records the sequence of thm_load_DATATYPE calls, other manipulations such as 
coordinate transforms, data processing options, or operations performed outside the GUI will not be reflected 
in the TGD document, and will probably cause problems when such a document is loaded.  Calibrations and 
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coordinate transforms specified through the "Load THEMIS Data" dialog should be correctly represented in the 
TGD file. 

4) Opening a TGD file is a DESTRUCTIVE operation that wipes out the current window configuration and 
loaded data, replacing it with the contents of the TGD file.  We recommend that users save their work before 
opening a new TGD file, and pay attention to any warning dialogs to avoid nasty surprises. 

5) As of the beta release of the new GUI, no versioning information is stored in the XML file, so it is very likely that 
TGD files created under this release may not be readable in later releases.  We hope to guarantee backward 
compatibility of TGD files once the GUI is out of beta and the internal interfaces have stabilized a bit.  

 
To open a TGD file, select "Open THEMIS Document…" from the File pull-down menu. This will bring up a pop-up 
dialog warning of the potentially destructive consequences of opening the file; if you're sure you want to proceed, click 
"OK" to dismiss the warning pop-up.  

 
A file picker dialog will appear.  Its appearance and exact functionality will depend on your platform; on Windows XP, this 
is what it looks like: 
 

 
 
Navigate to the file you wish to open, and click "Open" (or perhaps "OK", depending on your platform). 

 
This should trigger the process of loading the data specified in the TGD file you just opened; you should see progress 
messages scrolling by in the IDL command window.  It may take several minutes to load all the data, depending on how 
complex a document is being loaded; TDAS may also need to open an internet connection to the THEMIS data servers to 
download any data files not already cached on your local file system. 
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If all goes well, when the data is finished loading, the main draw window should update and show the plots for the first 
GUI window specified in the TGD file.  Other windows saved in the TGD file should be accessible through the "Window" 
drop-down menu button.  Any errors detected while parsing the XML file or loading the data will be reported by a pop-up 
error dialog, or a message in the status area at the bottom of the main GUI window. 

 

6.3.2 Save THEMIS Document 
 

Please refer to the caveats in section 6.3.1 regarding what is and is not represented in the THEMIS GUI Document 
format, particularly regarding coordinate transforms, data processing operations, and operations performed outside 
of the THEMIS GUI.  We recommend a workflow something like this: 

 
1) Use the "Load THEMIS Data" dialog to load the all the data you want to work with 
2) Use the "Window" menu and "Graph->Plot/Layout options…" dialog to create some plots 
3) Use "Save THEMIS Document" to save the window configuration, plot properties, and loaded data call sequence 

information, creating a "checkpoint" that can easily be restored later 
4) Perform any other manipulations (coordinate transforms, data processing routines, non-GUI operations), and be 

prepared to repeat them after opening the TGD file at some later time to restore the check pointed GUI configuration. 
 
When you're ready to save your plots and loaded data, click "Save THEMIS Document" under the File pull-down menu.   If 
this session has not yet been saved to a TGD file, a platform-specific file-saving dialog will appear.  On Windows XP it will 
look something like this: 
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Navigate to the directory where you'd like to save the file, select a new filename if you don't like the default, and click "Save" 
(or maybe "OK", depending on your platform). 
 
If "Save THEMIS Document" has already been invoked, or if the current session is the result of loading a TGD file, the file 
picker dialog will not appear, and the filename from the most recent save or open operation will be used again. 
 
If the file already exists, a pop-up will appear to warn that you're about to overwrite an existing file.  If you choose to 
proceed, the "save document" routine will try to confirm that you have write permission before attempting the save.  
However, due to an IDL bug on Windows platforms, the condition "write permission denied" is not properly detected, 
and will probably crash your entire IDL session if you attempt to save to a file without write permission.  This bug 
does not appear to affect Unix, Solaris, or Mac users. 
 
If the save attempt fails, an error message should be displayed, either in a pop-up warning dialog, or a message in the status 
area at the bottom of the main GUI window.  If the save succeeds, a success message will appear in the status area. 
 

6.3.3 Save As… 
 
The File->Save As… dialog also saves a TGD file.  The only difference between "Save THEMIS Document" and  
"Save As…" is that "Save As…" always pops up a file picker dialog, allowing one to change the filename associated with the 
GUI session.  "Save THEMIS Document" will reuse the last filename successfully saved to, only displaying a file picker the 
first time the GUI state is saved. 
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See the documentation for "Save THEMIS Document" in section 6.3.2 for more information about saving TGD files. 
 

6.3.4 Close Page 
 
The THEMIS GUI allows the user to have multiple pages.  If you wish to close a page there are several ways this can be 
done. The first is using the File pull down menu and selecting the Close option. The currently displayed page, or the ‘active’ 
page will be closed. Other pages will still be available. The main graph area will redraw the first page in the list, unless there 
are no more pages, in which case a blank graph area will be drawn. In addition, the Page pull down menu dynamic options 
will be updated and renumbered to reflect the change.  
 
Besides the file pull down menu, you can also type Ctrl-Z or select the Close option under the Page pull down menu.   
 
It should be noted that once a page is closed the settings that were associated with that page will be lost, unless you requested 
Save THEMIS Document under the File pull down menu before you closed the page. The data that was plotted in the page 
still remain are available for analysis and plotting. Only the plot settings are deleted. 
 

6.3.5 Load THEMIS Data 
 
The Load THEMIS Data option, under the File pull down menu, opens a window that allows the user to select specific data 
sets to be loaded into memory.  The left hand side of the window contains the data selection area and the right hand side of 
the window displays data that has already been loaded. 
 
In the Data Selection area, the user can select the instrument type, output coordinates, time range, probe and type of data. 
Once an instrument has been selected from the drop list widget, the coordinate system drop list will be updated to reflect the 
coordinate systems that are available for that instrument. If the data does not have coordinates, the drop list will be 
desensitized. The start and stop times can be typed into the editable text boxes. Some data types have large amounts of data. 
The user will be warned if the time range is excessively long.  In the bottom portion of the data selection area are text boxes 
that allow the user to select one or many (Ctrl-click or Shift-click) probes and level 1 or 2 data.  The Probe, Level 1 and level 
2 selections can be cleared at any time by clicking on the Clear Probes/Station or Clear Data Type buttons.  When your 
selections have been made, you can click the right arrow button in the middle of the data and the load process will begin. An 
hourglass will be displayed while the data is loading. When complete, the data tree will be updated and control returned to 
the user. Figure 6.3.5 shows the Load THEMIS Data window.  
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Data can be removed at any time by making a selection in the data tree and clicking the left arrow button.  The data tree will 
be updated to reflect the deletion.  The user can also use the Clear All button below the data tree to delete all data.  
 
At the bottom of the window is a status bar.  Messages regarding the load process, data, and/or status of the window will be 
displayed here. 
 
When you have loaded all the data you want, click the Done button below the data tree. 
 

6.3.6 Save Data As… 
 
The "Save Data As…" dialog allows the user to select a set of variables, and save the data as ASCII (with various formatting 
options) or as a set of files in the UCLA binary "upper flat file" format.  Unlike "Save THEMIS Document" or "Save As…", 
"Save Data As…" does not attempt to save any GUI objects or plotting parameters. 
 
Click "File->Save Data As…" to bring up the dialog.  On Windows XP, it will look something like this, assuming some data 
has already been loaded: 
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The left hand "Loaded Data" pane is a "tree widget" representing the data variables currently available.  In the above screen 
shot, many of the nodes are fully expanded.  Click any box showing "+" to expand that node, or click a box showing  
"-" to collapse that node.   
 
To the right of the "Loaded Data" pane are some additional controls.  If the "Restrict Time Range" box is checked, only the 
data with timestamps in the given time range will be saved.   For now, the start and end times must be typed into the text box 
in YYYY-MM-DD/HH:MM:SS format.  In a future release, we may add a graphical interface of some sort to specify the 
time range with mouse clicks and drags. 
 
If the "Save as Flat file" box is checked, the data will be saved in (binary) UCLA flat file format.  There are actually two 
formats available (upper/lower, or top/bottom in this dialog), but for this release, only the upper flat file format is supported. 
For further information about this format, please consult the UCLA documentation. 
 
If the "Save as ASCII data file" box is checked, the data will be saved as ASCII, one line per record.  If this format is 
selected, there are additional choices for how the ASCII data is formatted.  The "Time Format" drop-down menu brings up a 
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list of different formats for representing timestamps with varying degrees of precision.  The "Floating Point Format" drop-
down menu specifies the precision and format of floating point quantities that are not internally marked as timestamps. 
 
The "Header Style" drop-down menu offers a few options for including header lines in the ASCII output.  If "None" is 
selected, no header will be produced; for "Field Names Only", a single header line will be included, listing the field names 
associated with each data column; for "Tecplot", a Tecplot-compatible header will be produced with one line of field names, 
and another line with a sample count and some other information. 
 
The "Item Separator" drop-down menu allows the user to select whether columns are to be separated by commas, tabs, or 
spaces.  This option also applies to the header, if one is requested.  
 
As an example, if "Header Style" is set to "Field Names Only" and "Item Separator" is set to "Comma", the resulting ASCII 
file should be readable by Excel or other utilities that understand CSV ("comma separated value") formatted files. 
 
The "Indicate flags with:" text box allows the user to choose what gets printed if an IEEE-754 "NaN", "Inf", or other non-
numeric floating point value is encountered during the conversion to ASCII.  We suggest keeping the default text "NaN". 
(The term "flag" is used because in some situations, TDAS inserts NaN values to "flag" missing or invalid data samples.) 
 
"Update document with location of data" is not yet implemented in this release (and perhaps never will be), and should be 
disregarded for now. 
 
The suggested workflow for this dialog is to first use the tree widget in the "Loaded Data" pane to select some subset of the 
currently loaded variables, then use the controls on the right hand side to select a file format, an optional time range, and any 
additional style settings (if ASCII format is selected).  Clicking the "Save" button will perform a few checks on the selected 
data variables, and if the selection is valid, the GUI will pop up a file picker dialog to specify the filename and directory to 
save. 
 
Caveats: 
 
This dialog does not permit saving arbitrary collections of variables.  Owing to the record-oriented structure of these file 
formats, all selected variables must contain the same number of samples.  For UCLA upper flat file format, the only valid 
data types are 4-byte integers, and 4- and 8-byte floating-point values.  THEMIS data represented as bytes or 16-bit integers 
(for example, ASK) cannot be saved as UCLA upper flat files.  These restrictions are enforced at the very end of the 
workflow, when the user clicks "Save".  The first variable name with an incompatible sample count or data type will be 
mentioned in the error message; try removing that variable from the selection, and repeat the process until a valid ensemble 
of variables remains. 
 
ASCII files generated from large data sets (e.g. several hours of ASK keogram data) are potentially enormous, and 
may appear to lock up IDL for a long time while the file is being written.  Even modest ASCII data sets may require 
several minutes to be saved.  These operations are somewhat inefficient; due to the need for column-by-column checking, 
formatting, and output of data fields, such operations are difficult to put into vector formats in IDL without incurring a severe 
penalty in memory consumption. 
 

6.3.7 Manage Data and Import/Export Tplot 
 
The Manage Data Window allows you to import TPLOT variables into the GUI, export TPLOT variables from the GUI, 
delete GUI variables, and view/edit the meta-data associated with various GUI variables.   
 
To import TPLOT variables you can select one or many (ctrl/shift-click) tplot variables in the left TPLOT Data area, then 
press the right arrow button to move data into the GUI.   The data will then be moved into the GUI and attempt to detect the 
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variable meta-data that includes name, mission, observatory, instrument, units, and coordinate system.  Figure 6.3.7a shows 
the Manage Data window. 
 

 
 

When the right arrow is clicked to import tplot data, the Verify Data Window will be displayed allowing you to verify that 
this data was correctly detected. Click the OK button if it is or 'Cancel' if you change your mind about importing.  After you 
press 'OK' on the Verify Data panel, the data will be loaded. Figure 6.3.7b shows the Verify Data window. 
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To export GUI variables to TPLOT, select the GUI quantities that you would like to export from the tree at the right and 
select the left arrow button to export them. 
 
To delete GUI variables, select the GUI quantities that you would like to delete from the tree at the right, then select the trash 
can button to delete them. 
 
To examine the meta-data (name, mission, observatory, instrument, units, coordinate system, and file name) associated with 
particular GUI variables. Select the variable to be examined in the tree at the right and select the magnifying glass button to 
examine the meta-data.  A menu like the verify menu will pop-up and you can view or edit the meta-data for the selected 
quantities. 
 

6.3.8 Export Image To File… 
 
The Export to Image Menu allows you to generate an image file of your currently active page.   The THEMIS GUI supports 
the following file types:  Portable Network Graphics (.png), Encapsulated Postscript (.eps), Windows Meta-File (.emf, 
Windows Only), Windows Bitmap (.bmp), Graphics Interchange Format (.gif), Joint Photographic Experts Format/JPEG 
(.jpg), JPEG 2000 (.jp2), Apple PICT format (.pic), Portable Picture Map (.ppm), Sun Raster Format (.srf) . 
 
NOTE:  .EPS and .EMF both support vector output, which is needed if you want to resize without pixelation or load the file 
into Illustrator to select individual labels and ticks for editing.   To turn on vector output for either of these format types, 
press the 'Options' button and select 'Vector' 
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The directory to which you will output is listed at the top.  The 'Arrow' button will allow you to move up one directory.  You 
can also edit the directory by typing directly into the directory field, or selecting the desired directory from the directory list 
below. 
 
The file name for output is listed in the text box at the bottom.  Change the output format by selecting a different type from 
the 'Save As' dropdown menu at the bottom.  The 'Options' button will show the graphics output options for the selected file 
type.  These options will change depending on the file type.  They involve things like the size and resolution of the output 
file.   
 
When you are ready to actually save the file, select the 'Save' button, and the requested file will be saved to the selected 
directory.  If you change your mind select the 'Cancel' button or the 'X' in the corner. Figure 6.3.8 shows the Save Image 
window. 
 

 

6.3.9 Print 
 
When the Print option is selected under the File pull down menu an IDL print dialog window will be displayed. The default 
print device will be displayed and you can choose the number of copies you would like printed out.  If you do not wish to use 
the default printer listed, please see Section 6.3.11, Printer Setup, which allows you to select from all printers that are 
recognized by your system. In addition, the Printer Setup window allows the user to control additional print parameters. 
Figure 6.3.10 shows an example of the print dialog window. 
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6.3.10 Print Setup 
 
The Printer Setup option available under the File pull down menu allows the user to set up print parameters, select print 
devices, and print. The Print Setup option displays the standard IDL print dialog window.  All print devices that your system 
can detect are listed in the Select Printer box. In addition, you can control the number of copies, page range, collating details, 
and preferences associated with the print device you selected. For detailed information about this dialog box and the 
preferences you can set, please refer to the IDL User’s Guide. Figure 6.3.11 shows the Print Setup window. 
 

 
 

6.3.11 Properties… 
 
This button pops up a window that allows access to the system variables that control the automatic downloading process. You 
can type in values for the different options in the window. Note that you should not need to do this very often. 
 
The top window gives the local data directory. THEMIS data that are downloaded are written to this directory. The default 
value for users who are logged on to an ssl.berkeley.edu machine is "/disks/data/themis/". For windows users, the default 
value is "C:\data\themis\". It can be set to any directory for which the user has write permission. 
 
The second text box shows the remote data directory. The default is http://themis.ssl.berkeley.edu/data/themis/ 
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Next is the flag for automatic downloads; set this to 0 for automatic downloads, 1 for no automatic downloads. (This should 
be set to 1 for local SSL users, or anybody who has the entire database stored locally). 
 
Next is the flag for file updates, if set to zero this will update files in local data directories if there is a file in the remote data 
directory which has the same name, but is new. When this flag is set to 1, this is not done. Next is the download only flag; Set 
this to 0 to download and load data, set to 1 to only download data, and not load. 
 
The graphics mode allows you to select whether the graphics rendered are done with hardware or software. Rendering of 
graphics varies based on your system and platform. If your graphics are slow to display, you might want to switch your 
graphics mode. By default the GUI initializes to hardware. Whenever you click the save button, the configurations you 
selected will then be used as default values the next time you run the GUI.  
 
The verbose flag controls the number of messages that will be displayed. Set this to a number from 0 to 10. The higher the 
number, the more messages you get during processing. The Configuration Settings window is show below in Figure 6.3.13 
 
 

 
 

RESET - If you press this button, configuration settings are returned to their original state prior to opening this window. 
 
RESET TO DEFAULT - If you press this button, the configuration is returned to the default state in THM_CONFIG.pro, and 
any saved configuration file is deleted. This means that if you want to go back to a configuration that you have saved 
previously, you need to reset the values and then save the configuration. Alternatively, you can locate the previously saved 
file and copy it to the appropriate location in the APP_USER_DIR shown below. 
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SAVE - If this button is pressed, then the current configuration is saved in a file. This file ends up in a directory created by 
the IDL APP_USER_DIR routine, on a windows system the path looks like this: "C:\usernme\.idl\themis\thm_config-4-
win32\thm_config.txt". On a linux machine, it looks like: "$HOME/.idl/themis/thm_config-4-linux/thm_config.txt" 
 
Important:  Once you have saved this file, it will always be read when you run any THEMIS routines -- you should only need 
to do this once for each operating system that you are using.  
 
Whenever you save a new file, the old file is copied to a file tagged with the current date and time, for retrieval in case of 
disaster. 
 

6.3.12 Exit 
 
The Exit option under the File pull down menu will terminate the THEMIS GUI session. All windows will be closed and 
control returned to the command line.  
 

6.4 Edit Menu 
 
The Edit menu contains options that allow the user to copy images or pages and delete or zoom into marked areas. Figure 6.4 
shows the Edit pull down menu selections. 
 

 

6.4.1  Copy 
 
The Copy option in the Edit pull down menu will place a copy of the current or ‘active’ page on the clipboard.  You may also 
use the accelerator key sequence Ctrl-C to copy the current page. Once the image has been placed on the clipboard, the user 
may paste it into any program, such as a Word document. 
 

6.4.2  Delete Marker 
  
If markers exist and one has been selected, the Delete Marker option under the Edit pull down menu will remove the marker 
and redraw the page without the marker. Recall that when a marker is selected, the vertical lines bounding the marked area 
are drawn in blue. If no markers exist, or none have been selected the procedure will do nothing and you can continue with 
other GUI operations. 
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6.4.3  Subset 
 
The Subset option will create a new page based on the ‘active’ window or the selected marker. This menu item contains two 
submenus, Page and Marker.  
 
The first item, Page, makes a copy of the ‘active’ page and pastes that copy into a new page.  The original page is preserved. 
You can use the Page pull down menu to toggle back and forth between pages. 
 
The second item, Marker, zooms in to the selected marker. Like with Subset Page, the Subset marker option will create a new 
page, this time containing only the x range that is contained within the marker boundary. The original page is preserved.  
 

6.5 View Menu 
 
The View menu contains items that modify the look of the main GUI window and/or the page and panels displayed in the 
main graph area. 
 

 
 

6.5.1 Refresh 
 
You can use the Refresh option in the View pull down menu at any time to redraw the ‘active’ page. The Refresh option also 
has an accelerator key, Ctrl-R. 
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6.5.2 Scroll Forward/Backward 
  
Scrolling can be invoked in three ways, using the Scroll Forward or Scroll Backward option in the View pull down menu, 
using the left and right arrow keys, or by using the scroll icons in the toolbar. A scroll request will move the x-axis forward or 
backward by the range of a major tick. This operation will be done for all panels in the ‘active’ page. 
 

6.5.3 Expand/Reduce 
 
Similar to scrolling the Scrolling forward can be invoked in three ways, using the Scroll Forward or Scroll Backward option 
in the View pull down menu, using the left and right arrow keys, or by using the scroll icons in the toolbar. A scroll request 
will move the x-axis forward or backward by the range of a major tick. 
  

6.5.4 History Window  
 
The history window is a list of the steps, operations, and plots that have been executed during the course of your session, as 
well as warning and error messages. Just below the history window are buttons that allow the user to save the history in a file, 
and clear the history. The "Save" button will save the history in an IDL source file. When you click here, a file selection 
window pops up, allowing you to choose the filename and path for the file. The default file is 
"thm_gui_history_yyyymmddss.pro" and is located in your local working directory. The time stamp on the default file name 
is the local system time. The "Close" button close the history window. History window messages are not lost when the 
window is closed. History messages are recorded at all times while the THEMIS GUI is running, regardless of whether the 
window is displayed or not. 
 
Since the history information includes error message, it will be used as a debugging tool. When an unexpected error is 
encountered during your session, you will be notified with a message and the Error Report Form will be displayed. When the 
Save button is clicked in the Error Report window both the Error Report Form and the History file when the Save button is 
clicked in the History window only the history file is saved. In addition to history messages, IDL journal messages will also 
be appended to the file.   
 



 
 
 
 

 

NAS5-02099 File: THEMIS_Science_Data_Analysis_Software_Users_Guide   94  

 
 

6.5.5 Position Legend 
 
The Position Legend is the box in the upper right hand corner of each panel displayed in the ‘active’ page. The legend box 
displays a value for each variable within the panel. The value displayed is the value at the point where the vertical tracking 
line intersects the data line, in other words the x value of the data at the x position of the cursor. Whenever the cursor is 
moved the values in the legend box will be updated. Note that along with the y-axis labels, the legend labels and values are 
color-coded and synchronized with the color of the line within the plot. Figure 6.5.5a below shows an example of the legend 
box. 
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The legend box is only on when tracking is enabled. If tracking is enabled and the user can chooses not to display the legend 
box, they can turn the legend on and off by toggling the Position Legend option selection in the View pull down menu. The 
Position Legend is a checked marked menu item, when a check mark appears to the left of the menu name the position legend 
will be shown, no check mark indicates that the legend is off. Figure 6.5.5b below shows an example of a page with the 
position legend turned off.   
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It is worth noting that when a page is sent to a print device, the legend will not appear in the hard copy so that the area 
covered by the legend box can be seen. 
 

6.5.6 Status Bar  
 
At the bottom of the main GUI window is a status bar. The status bar displays text messages that provide information 
regarding the state of the GUI, the status of an operation, and other updates that are of interest to the user. If, during the 
course of your session, you have an unexpected result, it is worth checking the status bar. Most messages sent to the message 
bar are also recorded in the History message buffer. In the event that an expected error occurs due to incorrect usage of the 
GUI or request of an operation not allowed at that time you will be informed with an IDL dialog box. The dialog is popped 
up and you will need to either acknowledge the message or respond with a yes or no.   
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6.6 Graph Menu 
 

 

6.6.1 Panel Tracking 
 
Tracking can be toggled on or off by selecting the Panel Tracking option under the Graph menu. When tracking is on, you 
will see a vertical bar tracking any cursor movement that occurs inside the frame of a panel. This option is a checked menu 
item. When a check mark is displayed before the menu item name, Panel Tracking, then you will see the vertical line. When 
no check mark is present tracking is turned off. By turning off tracking, you also turn off the position legend box in the upper 
right corners of the panels.  This menu item will also turn off the Track One Panel and Track All options. 

6.6.2 Track One Panel  
 
The user can choose to turn the vertical tracking line to track only one panel at a time versus all panels. When this mode is 
selected the vertical tracking bar will track only the panel that the cursor is in. Similarly, if the position legend is on, only the 
legend box of the panel the cursor is in will be updated. This is a checked menu item and is on when the check mark is 
present and off when not. When tracking is in one panel mode, the track all option will automatically be turned off and the 
menu item will be unchecked. The Track One/Track All menu pairs are mutually exclusive so when one mode is on, the other 
will be turned off.  

6.6.3 Track All 
 
When in track all mode, the vertical line will track the cursor movement in all panels in the ‘active’ page. See section 6.6.2 
Track One Panel to see how the two menu items are paired.  
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6.6.4 Show Vertical Tracking  
 
Currently the tracking line is only displayed vertically. This menu item will be turned on whenever tracking is on, and off 
when tracking is off. This is regardless of whether tracking one panel or all panels. Future versions may implement horizontal 
tracking as well.  
 

2.1.2 6.6.5 Plot/Layout Options 
 
The Plot/Layout Options window allows the user to create panels and select data values for display on those panels. Panels 
can be added, deleted, and reordered. In addition, settings associated with panels and traces can be modified. 
 
The left hand side of the window is used for selecting data for display on the X and Y-axes. The right hand side of the 
window is for manipulating panels. If no data has been loaded or panels created both these text areas will be blank. The 
Variable section at the bottom of the window allows the user to select variables for display below axes. 
 
There are two modes for selecting data for display, Linear and Spectral. The default mode is Linear. When in linear mode the 
user can choose to select both X and Y data for display, or select only Y data, allowing the X-axis to default to time.  When 
the window is initialized it will default to Y only data selection. The Show X Data check box located in the upper left hand 
corner of the window provide a way to toggle between the two modes. When X data is shown, both X and Y-axes data trees 
will be decomposed into individual components. When the Show X Data is not checked, the Y-axis data tree will expand to 
show only data sets. Figures 6.6.5a and 6.6.5b show examples of both.  
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Once data is selected the user can click on the ‘Add->’ button to add it to a panel.  For the first addition, if no panels exist, 
one will be created automatically and named, Panel 1(1,1). This is not true for subsequent additions. If you want to display 
data on a different panel, you must first click the ‘Add’ button on the far right hand side of the window otherwise the data 
will be placed on the most recently selected panel.   
 
As new panels are added the panel number will increase sequentially, regardless of whether earlier panels were deleted or 
reordered. The row and column numbers are displayed in parenthesis next to the panel number.  It is important to note that 
Panel numbers do not change, however, row and column values can 
 
The user can choose to delete a panel or trace by selecting (or highlighting) the item in the panel text box and clicking delete. 
Further, the user can modify panel or trace settings by selecting the item and clicking the Edit button.  See Sections 6.6.5.1 
and 6.6.5.2 for additional details. 
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The Up and Down arrow buttons provide a way to reorder panel rows or trace location on the panel. The left and right arrow 
buttons move panels by column. Panels can be overlaid, in other words, they can have the same row and column number. The 
user needs to be aware of this feature when reordering so that care can be taken to ensure the correct layout is created.  
 
The row and column number of a panel can be changed using the Row and Column spinner widgets below the arrow buttons. 
The total number of rows and columns per page can also be modified. Please note that the total number of page rows and/or 
columns cannot be set to a value less than the largest row and/or column value (e.g. Panel 4(5, 2) – Panel 4 is displayed in 
row 5, the user cannot change the total rows to any value smaller than 5, likewise, in this example, total page columns must 
be greater than or equal to 2). 
 
To plot spectral data the user must switch from linear mode to spectral by clicking the Spectral button. The window will be 
displayed with a Z Axis selection box. All other operations remain the same as described for linear data. The user can toggle 
back to the linear layout options window by clicking the Linear button. If linear data is selected while in spectral mode or 
spectral data selected while in linear mode the data may not be added to the panel, or if added the results might not be as 
expected. Figure 6.6.5c shows an example of the window for spectral data.  
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At any time the user can click the Apply button to view the panel layout, the OK button to commit the layout, and close the 
window, or Cancel to undo changes and close the window. 
 
At the bottom of the Layout Panel is a variable section. The text box will display any variables that have been chosen for 
display below the x-axis. The user can also click the Add button to bring up the Variable Options window. See section 6.6.10 
for details on creating variables for display.  

6.6.5.2 Edit Trace 
 
When a trace (or line) is highlighted in the panel window and the Edit button clicked the Line Options window will be 
opened. The Line Options window allows the user to modify any settings that are associated with plotting the line. The Edit 
button is for traces only and will not open if a panel is selected. 
 
At the top of the window the user can change the panel and x and y-axes, the window will default to whatever the user 
selected in the Plot/Layout Options window. Once a trace is selected each widget will be updated to show the current settings 
for that trace. Line and symbol settings, as well as symbol frequency can be modified on this window. Figure 6.6.5.1 shows 
the Line Options window. 
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Line Modifications  
 

Show: The show check box determines whether the line is displayed or not. A check indicates the line will be 
drawn. 
 
Mirror:  The mirror check box will draw a horizontal line at zero and reflect the trace below.  
  
Sync Labels to Line:  If the color of the trace is changed, this check box when turned on will also change the color 
of the label so they match.  
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Color: The color button will open the color palette allowing the user to select a different color. When a new color 
has been accepted the current color swatch next to the button will be updated to reflect the change. If the Apply or 
OK buttons are clicked the trace will be drawn in the new color. 

  
Style: The line style drop list contains all the line styles that IDL allows (e.g. dashed, dotted, etc..).  
 
Thickness: The thickness spinner widget lets the user change to size of the line.  
 

Symbol Modifications 
 

Show: The show check box will determine whether the symbol is displayed in the plot, or not. A checked box 
indicates the symbol will be drawn. 
 
Fill: Fill has not yet been implemented, however, when checked the symbol will be filled in with the selected color. 

 
Style: The symbol style drop list lets the user choose any of the symbols that IDL allows. 
 
Color: The color button will open the color palette allowing the user to select a different color. When a new color 
has been accepted the current color swatch next to the button will be updated to reflect the change. If the Apply or 
OK buttons are clicked the symbol will be drawn in the new color. 

 
Size: The size spinner allows the user to increase or decrease the display size of the symbol. 

Symbol frequency has five options for determining when a symbol is drawn and include:  First Point, First and Last Point, 
Last Point, Major Ticks, or Every x points. If the Every x points button is clicked a numeric value can be specified in the 
spinner widget (e.g. a value of 20 will plot a symbol every 20th point).  

As with all graph options windows, the user can click the OK, Apply, or Cancel at any time. 
 

6.6.6 Page Options  
 
The Page Options window controls all settings global to the current page, and can change a given attribute (e.g., the label 
color) everywhere on the page at once.  Select Page Options in the Graph pull down menu.  Accepting/canceling changes: 
Clicking OK accepts the changes and refreshes the page.  Clicking Apply accepts the changes provisionally and refreshes the 
page.  Clicking Cancel rejects any changes and refreshes the page.  Dismissing the window via the operating system (‘X’ 
button) has the same effect as clicking Cancel. 
  
The Text tab (shown in the Figure) lets the user set the title and the footer.  (The default marker title is not yet implemented.)  
The Font Style frame controls font, font size, and font color (a color dialog box opens – see Figure) for the title, labels, 
variables, the footer, and for markers.  Use the Show check boxes to hide or show the title and footer. The Text Tab of the 
Page Options window is shown in Figure 6.6.6a. 
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The Layout tab (shown in the next Figure) has four active frames: Panel Arrangement, Margins, Canvas Size, and 
Background.  Panel Arrangement: The horizontal and vertical panel spacing sets the horizontal and vertical distance between 
columns and rows (respectively) of the panels.  Margins: The top, left, right, and bottom margins set the distance (in inches) 
from the corresponding edge of the canvas to the nearest panel.  The margins must be at least 0.1 inches.  Canvas size: The 
dimensions of the page in inches.   
 
The Mark Proportional to Range check box, the gutter frame, and the Data tab will be implemented in a future release, and a 
future version of this User’s Guide will discuss their functionality. 
 
The Layout Tab of the Page Options window is shown in Figure 6.6.6b 
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6.6.7 Panel Options 
 
The Panel Options window allows the user to modify the traces (or lines) that are on a panel as well as the layout of the 
panel. 
 
In trace tab of the Panel Options window has a drop list widget that contains all the panels that reside on the current or active 
window. When a panel is selected, the Trace text box directly below the drop list will be updated to show the traces residing 
on that panel. Once a panel has been selected the user can click on a trace to select and highlight it.  
 
The functions available for modifying traces include Add, Delete, Edit or Set Same. The Add button will open a window 
containing the loaded data options (similar to the Load THEMIS data option under the File pull down menu) where the user 
can select new data values for display. The Delete button removes the highlighted trace from the panel, and the Edit button 
will open the Line Options panel for changing the display settings for that trace.  The up and down arrows below the buttons 
will move the highlighted trace up or down in the list of traces. Moving the position of the trace in the list will result in 
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changing the order of the y-axis labels.  At any time the OK, Apply, or Cancel button can be clicked to commit, view, or 
undo the changes.  Figure 6.6.7a shows the Panel Options window Trace tab. 
 
 

 
 
The Layout Tab of the Panel Options window provides many options for changing the Title, Placement and color of the 
panel. Similar to the Trace Tab, the user must first choose a panel to modify by clicking on the Panel drop list widget. The 
drop list will default to the first panel on the list if no selection is made.  
 
A title can be placed on the panel by entering text into the Title text box. The panel title margin can be set by typing a 
numeric value into the spinner widget or by using the up and down arrow keys to increase or decrease the size.  
  
The placement section allows the user to alter the row and column the panel resides in, as well as the row span or column 
span. The row and column span specifies the number of rows (vertically) or columns (horizontally) the panel will use (e.g. a 
row span of 3 will result in that panel taking up 3 rows of space, that is, the panels vertical size will extend over 3 rows). In 
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addition the margins for the panel itself, top, bottom, width and height can be set by clicking on any of the check box items 
and entering a numeric value and unit. 
 
The Color section provides a way to change the background and frame color as well as the thickness of the frame.  
 
The Set All button at the bottom of the window will make the modifications to all panels on this page, not just the one 
selected in the Panel drop list. 
 
An example of the Layout Tab of the Panel Options window is shown in Figure 6.6.7b.  

 

 
 

6.6.8 X/Y Axis Options  
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The X-Axis Options window controls the x-axis settings for the selected panel (use the panel drop down menu at the top of 
the window to change the selection).  To get X-Axis Options, select it from the Graph pull down menu. Accepting and 
canceling changes: Clicking OK accepts the changes and refreshes the page.  Clicking Apply accepts the changes 
provisionally and refreshes the page.  Clicking Cancel rejects any changes and refreshes the page.  Dismissing the window 
via the operating system (‘X’ button) has the same effect as clicking Cancel. 
 
The Range tab sets how the GUI determines the displayed range and gives a special option for when the axis displays time.  
If the axis is time, then the ‘Is Time’ check box should be set.  When the axis is time, then only the fixed Min/Max frame, 
and the Set All Panels button are active.  (A note about Set All Panels: This button works individually for each tab.  Any 
operations done on a given tab after setting the button will propagate to all panels.  Behavior with Locked X-Axes on the X-
Axis only: When Locked X-Axes in Plot/Layout Options is checked [the default], the GUI will check Set All Panels for the 
Range, Ticks, and Grid tabs, while unchecking Set All Panels for the Annotation and Labels tabs.  We recommend that the 
user keeps these settings for the Annotation and Labels tabs when axes are locked.)  When the axis is time, the GUI 
represents the Min/Max range in date/time format.  When the data is not time (uncheck Is Time), the Range and Scaling 
sections become active.  The Range Options buttons now make active (only one at a time) the following frames: Auto Range, 
Floating Center, and Fixed Min/Max. 
 
Auto Range: The range margin sets a margin between the plotted data and the plot box edge (above and below) as a 
percentage of the maximum minus the minimum of the displayed data.  The bound auto-scaling range puts absolute limits on 
how big the range can get; auto-ranges fully within the bounds are unaffected.   
 
Floating Center: The GUI determines the center as a mean, or median of the data (the approximate mean/median options 
currently function identically to the mean/median options.).   If the axis uses linear scaling the the floating range is calculated 
using the following equations.  Minimum Range = center – span,  Maximum Range = center + span.  If the axis uses 
logarithmic scaling then the floating range is calculated using the following equations:  Minimum Range = base ^ 
(log(center) – span), Maximum Range = base ^ (log(center) + span).    In other words, the span of the floating center on a 
logarithmic plot is the number of orders of magnitude above and below the center that should be included in the plot. 
In the equation above 'base' is either e or 10, and 'log' is either the natural logarithm or the base 10 logarithm, depending upon 
the type of log scaling that is used. 
 
 
If the axis is  Fixed Min/Max: The user determines an absolute range.   
 
Scaling: The user can select linear, logarithmic base 10, or natural logarithmic scaling. Figure 6.6.8a shows the Range Tab of 
the X/Y Axis Options window. 
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The Ticks tab sets where and how to draw the axis ticks, and contains two frames for Placement and Length.  By default, the 
GUI determines ticks automatically.  ‘Number’ changes the total number of major ticks for the axis (‘Major tick every’ row), 
or the total number of minor ticks for the axis (‘Minor tick every’ row).  If the axis is time, ‘Units’ sets the tick frequency in 
common time units, otherwise Units is not active.  ‘First tick at’ specifies how far the first tick should be placed beyond the 
minimum range of the plot.  It defaults to 0, meaning that the first tick is placed at the minimum range.  The ‘Tick Style’ 
dropdown provides Inside, Outside, or Both Inside and Outside options.  The Placement frame has right and left buttons that 
switch ticks on/off for the right and left y-axes of the plot box.  The Length frame controls the lengths of the major and minor 
axes. Figure 6.6.8b shows the Ticks Tab of the X/Y Axis Options window. 
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Like the floating center, the 'Major Tick Every', 'Minor Tick Every', and 'First Tick At' options will be measured in orders of 
magnitude of data units if the axis is logarithmically scaled and data units if the axis is linearly scaled.   
 
Here are some examples that explain how these options work: 
 

• If the axis has linear scaling, the minimum range of the axis is 50, the maximum range of the axis is 100, 'First Tick 
At' is 5, and 'Major Tick Every' is 10, major ticks will be placed at 55, 65,75,85, and 95. 

• If 'First Tick At' is 0, but the other settings unchanged, then ticks will be placed at 50,60,70,80,90,100.  
• If the range of the axis is from 10^1 to 10^6,  the axis has base 10 logarithmic scaling,  'First Tick At'  = 1 and 

'Major Tick Every' = 2.  Then major ticks will be placed at 10^2,10^4  and 10^6.  
•  If  'First Tick At' were 0, but the other settings remained the same then major ticks would be placed at 

10^1,10^3,10^5 
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The Grid tab has a setting for the Panel Frame Thickness (which includes the tick thickness), and two frames to implement 
Major and Minor Grids (color, thickness, and style). Figure 6.6.8c shows the Grid Tab. 
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The Annotation tab allows control over annotation settings for the major ticks.  This tab can also draw a single line at axis 
zero (checkbox).  (Note that the line appears at axis 1 for logarithmic scaling.)  The annotation format dropdown has a variety 
of format options and the GUI provides time formats when the axis is time.  The user can also choose to annotate the first 
and/or the last tick (‘Annotate first’/’Annotate last’).  (Note that the first/last tick often coincides with the edges of the plot 
box.)  Check ‘Show Date’ to show the date (in the lower left corner of the panel region) and control its format.  Check 
‘Annotate Along Axis’ to control the placement (top or bottom x-axis), frequency, orientation, font, font size, and color of the 
x-axis annotations. 
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The Labels tab controls whether the labels are shown and/or stacked.  Check both ‘Show Labels’ and ‘Show Label’ to show a 
label.  The Style frame sets orientation and margin (globally to the given axis and panel), and font, format, font size, and 
color (for individual labels). The Labels Tab on the X/Y Axis Options window is shown below in Figure 6.6.8e 
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6.6.9 Z Axis Options 
 
The THEMIS GUI allows graphing of three-dimensional spectral quantities from the spacecraft as well as ground-based 
keograms.  See the Section 6.6.5 Plot/Layout Options for details on graphing spectra. Figure 6.6.9a shows examples of 
spectral data. 
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Once spectral plots are created their extra display features and parameters can be edited in the Z Axis Options found under 
the Graph pull down menu in the main window.  Options for the X and Y-axes are still functional and can also be found 
under the Graph pull down menu. 
 
Settings: 
 
The Settings tab (figure 6.6.9b) contains display and annotation options.  The Panels drop list contains all plots in the active 
page that have z-axes.  
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Color Table:  The color table section allows the user to change the color scheme being mapped to z-axis values on the active 
panel.  A preview of the current selection can be seen on the right.  The color bar represents numerical values in decreasing 
order from top to bottom. Colors are mapped to numerical values according to the chosen Scaling. 
 
Scaling:  Determines how the selected Color Table is mapped to z-axis values.  Values within the range are assigned linearly 
by default but can be assigned according to a base-ten or natural logarithmic scale. 
 
Placement:  Sets the position of the Color Bar (see fig. 6.6.10a).  The Color Bar displays the color scheme of the associated 
panel plus numeric annotations for scaling. 
 
Number Ticks:  The number of “ticks” (i.e. scaling annotations) that are displayed along the Color Bar.  Ticks will only be 
displayed if the Color Bar is present. 
 
Margin:  The distance, in number of pixels, between the plot area and the Color Bar. 
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Range:  The z-axis range is automatically calculated by default and the color table is mapped with the selected scaling.  
Checking the Fixed Min/Max box allows the user to specify the maximum and minimum values for the plot.  Values above or 
below the limits are respectively assigned the color corresponding to the maximum or minimum value. 
 
Text: 
 
The text tab (figure 6.6.9c) contains options for formatting z-axis annotations and adding/formatting z-axis labels.  The 
Panels drop list contains all plots in the active page that have z-axes. 
 

 
 
Label 

 
Text:  Enter text here to create a label for the Color Bar. 
 
Font:  Select the font for the text entered into the Text box to be displayed in. 
 
Format:  Select formatting options for Label text such as bold and italic. 
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Size:  The font size for the Label text. 
 
Color:  The color button will open the color palette for selecting the color of the Label text.   
 
Label Margin: The label margin spinner sets the size of the margin before the Label. Margin values are in points.  
 
Orientation: Labels can be drawn horizontally or vertically. 

 
Annotation 

 
The annotation section allows the user to set the same parameters as Labels with the exception of entering text and setting 
annotation margins. 
 

2.1.3 6.6.10 Variable Options 
 
The Variable Options window (see Figure) lets the user add variables beneath the selected panel.  To get Variable Options, 
select it from the Graph pull down menu. Accepting and canceling changes: Clicking OK accepts the changes and refreshes 
the page.  Clicking Cancel rejects any changes.  Dismissing the window via the operating system (‘X’ button) has the same 
effect as clicking Cancel.  An Apply button to accept changes provisionally will be available in a later release.  Figure 6.6.10a 
shows an example of the Variable Options window. 
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To add variables, click the add button (‘+’).  The ‘Add Variable(s)’ dialog appears with a tree view of the loaded data.  Select 
individual data products, or entire branches.  Shift-click or ctrl-click to select ranges or elements.  Click OK to accept the 
selections, or Cancel to start over.  Any selections now appear in the Variables frame on the left.  Click OK to accept and 
have these variables appear below the current panel, or Cancel to exit Variable Options with no changes.  The user may also  
select a variable (click on it) to change its attributes (see the Attributes frame on the right), to delete it (‘-‘ button), or to 
change its position in the list (up and down arrows).  The Label Margin (below Attributes) changes the margin between all 
variables (for the selected panel) and the left y-axis of the plot box, and also changes the margin between the variable legend 
and the right y-axis of the plot box. An example of the Add Variable window is shown below in Figure 6.6.10b. 
   

 
 
The Attributes frame: The Field attribute shows the proper data name of the variable and never changes.  The Control 
attribute shows which data name represents the abscissa for the variable.  By default, the GUI sets the control to the time data 
for the Field.  The Text attribute changes the name of the variable as displayed in the Variables frame on the left and on the 
plotted panel.  The Symbol attribute currently has no effect, but will annotate symbols on a variable in a later release.  The 
Format attribute sets the format of the variable annotations (time formats for time variables, floating formats for numeric 
variables).  The color attributes set the color of the selected variable.  The ‘Include units in label’ check box currently has no 
effect.  Use the ‘Show Variable’ check box to show or hide a variable on the plot.  Status information on the window 
operations appears in the status bar at the bottom of the window. 
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A note on locking axes: The GUI hides all variables except those on the last panel when ‘Lock X-Axes’ is checked (see 
Plot/Layout Options on the Graph pull down menu).  This behavior may be modified in later versions. 
 
 

6.7 Analysis Menu  
 
The Analysis pull down menu contains selections that allow you to perform various functions on data. Figure 6.7 shows the 
Analysis Menu options. 
 

 

6.7.1 Calculate 
 
The Calculate Window allows you to access a built in language that will perform simple vector operations on GUI data. The 
Syntax of the language itself is described in section 5 of the manual.   Commands for the language can be typed into the text 
box on the left.  Each line will be treated as a separate line.  If you want to insert a particular data quantity, just select the 
quantity from the menu at the right and the quantity will be added to the program text box.  You can also insert variables that 
store the values of numerical constants by selecting them from the drop list in the lower right corner of the window. 
 
Rather than typing your commands in the GUI you can also type a GUI program in a plain text file and load it into the GUI 
by selecting the 'Open' button at the bottom.  If you want to save the program that you currently have in the text box, select 
the 'Save' button at the bottom of the window.  
 
When you are ready to run the program, select the 'Run' button at the bottom and the Calculate program will be executed.  
Any quantities that are created will be automatically loaded into the GUI, but if they are much different from the quantities 
that they came from you may want to double check their meta-data in the manage data menu.   
 
To exit this window, click on the 'X' in the upper right hand corner of the window or the 'OK' button at the bottom of the 
window. The Calculate window is shown in Figure 6.7.1.  
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6.7.2 Nudge  
 
The Nudge Traces option allows the user to “nudge” a trace on a line plot.  “Nudging” simply shifts the given trace by a 
specified amount of time. To activate, select “Nudge Traces” from the “Analysis” pull-down menu on the Main GUI. Note 
that you need to have created a page and panel and plotted some data before anything will happen when you make this 
selection. If there has been data plotted, then a window will pop up, allowing you to select the panel, and trace that will be 
nudged. An example of this window is shown below. There are two drop-down menus that allow you to select the panel and 
trace that will be nudged. For the current selection, panel 1 is selected, and the trace “tha_state_pos_x” is selected. The units 
(time units or records) are selected on the right side of the panel; in the example the shift will be given in hours. The number 
of hours (or minutes, or seconds, etc…) can be selected in the window below the trace selection window. Note that you can 
type a value into this window as well as use the arrows on the side to scroll values.  
 
When the “Apply” button is clicked, the trace is shifted. This is accomplished by creation of a new variable. The amount of 
the shift is recorded in the variable name to avoid confusion, to allow for easy recovery of the original values, and to allow a 
nudged variable to be plotted along with the original. In this example, the new variable name is “tha_state_pos_x_3_hr” and 
is shown on the panel where the nudged trace is plotted.  
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Warning: Note that traces are shifted one at a time. If you are attempting to nudge a spectrogram (e.g, THEMIS ESA or SST 
flux spectrograms, or ASK All Sky Keograms) then you may get unpredictable results when the plot shows up.  
 

6.7.3 Data Processing  
 
When you click on “Data Processing…” on the Analysis pull-down menu on the Main GUI, a window pops up that allows 
you certain data processing tasks.  
 
This window is shown below. On the left side is a window that shows the data that has been loaded. You can click on each 
variable in this window, and set it to “active” by clicking on the right arrow button in between windows. This process works 
both ways; you can set data to “inactive” by clicking on it in the right-hand window and clicking the left arrow button in the 
middle. You also have the option to clear the active data by clicking the “Clear Active” button. Data processing tasks are 
only possible when there is “active” data.  
 
In this window, the “active” data set is “tha_fgh”. Any data processing task will affect these data only.  Note that it is not 
possible to select individual traces for data processing; the full variable is processed. 
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A data processing task will change the active data set to be the data that has been just been created, so once a task is finished 
this variable will show up in the right-hand window, and also it will be added to the loaded data tree on the left. Clicking the 
“Done” button closes the window. 

6.7.3.1 Subtract Average  
For each active data set, the average value is subtracted. new variables are created, the new names have the syntax: new_var 
= old_var+"-d", and the new variables become the active data sets`. Note the change in both windows in the figure below, the 
new variable has been added and set to active. 

6.7.3.2 Subtract Median  
For each active data set, the median value is subtracted. new variables are created, the new names have 
the syntax: new_var = old_var+"-m", and the new variables become the active data sets. 

6.7.3.3 Smooth Data 
This process performs boxcar smoothing of the data. A widget will pop up, asking for the size of the time interval to smooth 
over. Choose a value, and click on "Accept and Close". The default is 61 seconds. New variables will be created, with 
"_sm_dt" appended to the old variable names, where dt is the smoothing resolution. Click “Cancel” to cancel the operation. 
 

 
 

6.7.3.4 High Pass Filter 
Click this button to apply a high-pass filter  to the data; a window will pop up asking for the time resolution for the smoothed 
data that will be subtracted from the original data to apply the filter. 
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6.7.3.5 Block Average 
Click this button to average that data over time; a window will pop up, asking for the time resolution. The default time 
resolution is 60 seconds. New variables will be created, with "_av_dt" appended to the old variable names, where "dt" is the 
time resolution. Click “Cancel” to cancel the operation. 
 
   

 

6.7.3.5 Clip 
Clips data above and below a set maximum and minimum, a widget pops up which allows these values to be set. Then data 
outside the range is set to NaN.  New variables will be created, with "_clip" appended to the old variable names. Click 
“Cancel” to cancel the operation. 
 

 

6.7.3.6 Deflag 
Interpolates or repeats the most recent valid data value over gaps in the data (gaps are denoted by NaNs, and can be created 
by the clipping process; a “deflag” often happens after NaN values are inserted by a “clip” operation). A window pops up 
which is used to set the method, there are two choices: "repeat" will repeat the last good value over the gap; "linear" will 
interpolate over gaps. New variables will be created, with "_deflag" appended to the old variable names. Click “Cancel” to 
cancel the operation. 
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6.7.3.7 Degap 
The degap procedure locates gaps in data, and fills them in with 'NaN' values, so that the plotting process displays the data 
gaps correctly (Otherwise it simply draws a line across the gap). It figures out where to add data points by checking which 
time differences are greater than or equal to an input time interval, plus a margin, and inserts equally spaced 'NaN' data points 
at time intervals with spacing determined by the size of the data gap divided by the number of points that fit with minimum 
cumulative error. Click “Cancel” to cancel the operation. 
 

 

6.7.3.8 Clean Spikes 
This process removes large single point spikes from messy data. New variables are created, with "_dspk" appended to the old 
variables. 

6.7.3.9 Time Derivative 
This process takes the time derivative of the active data sets. New variables are created, with "_d" appended to the original 
variable names. 

6.7.3.10 Wavelet Transform 
The data is split into components, and a basic wavelet transform is performed on each component, with "_wv" appended to 
the old variable names. (Note that this is designed for data that are either electric or magnetic field data type. Applying this to 
other data (e.g., spectrograms) will cause non-intuitive results.) 
 
Since this process can be very memory-intensive, the user is first asked to specify a time range. A window allows the user to 
input start and end times. 
 

 
 

Note the values shown here are rough estimates of the available memory and estimated memory usage. If they are close, then 
it is advisable to click the “NO” button. The process will continue if the “YES” button is pushed. Typical machines have 1 to 
2 G-bytes of memory as of this writing (Feb-2009), but if there has been data loaded the available memory may be less. For 
Window PCs IDL may be limited to 2 GB or less. 
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6.7.3.12 D Power Spectrum   
The data is split into components, and a dynamic power spectrum is obtained from each component, with "_dpwrspc" 
appended to the old variable names. Note that this is designed for data that are either electric or magnetic field data type. 
Applying this to other data (e.g., spectrograms) will cause non-intuitive results.  
 

6.7.3.13 Coordinate Transform 
When the "Coordinate Transform" button is clicked, a dropdown menu appears with different choices for coordinate 
transforms. Each possible output coordinate system has a button.  The possibilities are: "SPG" (Spacecraft Probe 
Coordinates), "SSL" (Spinning Spacecraft Coordinates), "DSL" (Despun Spacecraft Coordinates), "GSE" (Geocentric Solar 
Ecliptic), "GSM" (Geocentric Solar Magnetospheric), "GEI" (Geocentric Earth Inertial), and “SM” (Solar Magnetic). 
 
Only the active data sets are transformed.  The input coordinate systems for the active data sets are automatically obtained.  
Data with "Unknown" coordinates and ground-based data will not be transformed. Note that state data for the appropriate 
THEMIS probe is necessary for the coordinate transform to occur. If it is not present, then a pop-up will alert the user, and 
give the option to load the state data. 
 
Click on the "Transform" button to perform the transformation. Warnings and error messages will appear in the text window 
at the bottom, and also in the progress window on the main widget. Click on the "Close" button to dismiss the popup. 
 

6.7.3.14 Particle Spectra 
A click on the “Get Particle Spectra” button results in the pop-up window shown below.  This window is an interface to the 
TDAS routine “THM_PART_GETSPEC”, which is described in section 5.5.3.4. THM_PART_GETSPEC Operates on Level 
1 SST and ESA data only. For each data type, (e.g., peif, peef, psif, psef, etc...) all of the L1 data must be loaded. For ESA 
data, this is done automatically when a data type is chosen from the Load THEMIS Data widget. For SST you need to click 
on all L1 variable choices for each given data type when loading. Be sure that all of the appropriate data is loaded. For pitch 
angle and gyro-velocity distributions, FGS and STATE data for the appropriate probes are also necessary. These will be 
automatically loaded if they have not been loaded already. 
 
The top window on the left side allows you to choose a suffix for the new variables that are created. 
The drop-down menu below this allows you to choose the type of angular particle distribution to create. The choices are 
“PHI”, in degrees relative to probe-sun direction in spin plane, “THETA”, in degrees relative to spin plane or the azimuth for 
pitch angle distributions, “PA”, for pitch angle, degrees relative to the magnetic field, and “GYRO”, for gyro-velocity 
distributions. (See section 5.5.3.4 for details about the various angular choices.) 
 
The set of windows below allows the user to set minimum and maximum values for the different angular ranges, and a start 
angle for the PHI option. Below these are windows allowing the user to set energy and time ranges.  In the energy range box, 
there is a check box labeled “Return Energy Spectrum”; if this is checked, then the process will create an energy spectrum for 
the data integrated over the full angular range. 
 
On the right side there is first a check-box labeled “Normalize Spectrum”, if this is checked, then the spectra are normalized. 
The windows below allow you to change the number of points used to re-grid the angular data for interpolation. The 
dropdown below this allows you to change the default value for the second axis for conversion to field-aligned coordinates, 
used for pitch angle and gyro-velocity distributions. The next window allows you to specify the maximum gap in seconds 
over which data are interpolated.  
 
The options below this are all restricted for use for SST data, if the check-box for SST mask removal is checked, then the 
value in the box below this will be the proportion of values that need to be zero at a given time for the program to decide that 
a mask is present.  If the box for SST Sun Contamination is checked, then the drop-list menu below can be used to choose the 
sun pulse cleaning method for contamination removal. The window below this is used for the value of the standard deviation 
tolerance for sun pulse cleaning, and finally the drop-list menu below this allows you to specify the default method for filling 
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in points that are removed; either “INERPOLATION” or “SPIN_FIT”. For a more detailed explanation of the input 
parameters, please see section 5.5.3.4. 
 
To initiate the process, click the “Apply” button. New variables are created, and appended with the input value for the suffix. 
For example, if “tha_psif” data is used with the “PHI” option set, the angular spectrum will have the name 
“tha_psif_an_eflux_phi_part_spec” and if the energy spectrum is calculated then this variable will have the name 
“tha_psif_en_eflux_part_spec” as shown here. 
 

 
 

6.8 Page Menu 
 
The Page pull down menu contains options to open, close and toggle between pages. The Page menu options are shown 
below in Figure 6.8.  
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6.8.1 New 
 
The New option under the Page pull down menu will open a new page. The new page will be blank since no data or panels 
have been selected.  Figure 6.8.1 shows an example of a new page. In addition, the new page will be added to the Page pull 
down menus. To create new panels on this page select the Plot icon button on the tool bar or the Plot/Layout option under the 
Graph menu.  
 

6.8.2 Close 
 
The THEMIS GUI allows the user to have multiple pages.  If you wish to close a page there are several ways this can be 
done. The first is using the Page pull down menu and selecting the Close option. The currently displayed page, or the ‘active’ 
page will be closed. Other pages will still be available. The main graph area will redraw the first page in the list, unless there 
are no more pages, in which case a blank graph area will be drawn. In addition, the Page pull down menu dynamic options 
will be updated and renumbered to reflect the change.  
 
Besides the file pull down menu, you can also type Ctrl-Z or select the Close option under the File pull down menu.   
 
It should be noted that once a page is closed the settings that were associated with that page will be lost, unless you requested 
Save THEMIS Document under the File pull down menu before you closed the page. The data that was plotted in the page 
still remain are available for analysis and plotting. Only the plot settings are deleted. 
 

6.8.3 Pages  
 
The lower portion of the Pages pull down menu contains dynamic menu items and is dependent on the number of pages that 
have been created. Figure 6.8 above, shows an example of the pull down menu with three pages.  Each of the dynamic menu 
items are checked menus. Only one page can be checked or displayed at a time, since only one page can be displayed at a 
time. The user can toggle between pages by simply clicking the page they wish to view. When new pages are created a new 
menu items is added to the list. Likewise, when pages are closed, the menu items are renumbered to reflect the new page 
count. If all pages have been closed, the last page (page one) will be cleared, however it will remain as a blank page. 
Similarly, when the GUI is initialized there a blank page is already created. 
 

6.9    Help Menu 
 
The user can view a text version of this document or create a help request form. Figure 6.9 shows the Help pull down menu 
options. 
 

 

6.9.1 Help Window 
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Clicking on the Help menu and selecting Help Window… will open a dialog box that will provide you with the URL for the 
online User’s Guide document.  Figure 6.9.1 shows the help dialog window. 
 

 

 
 

6.9.2 Help Request Form 
 
When this button is clicked, a text window pops up displaying the THEMIS Science Help Request Form. This allows the user 
to input information about the error which has occurred. There is a save button, which saves the help request form in a file. In 
addition to the request form a History file will be save containing History window and journaling messages. You will be 
informed where both files are located.  Both files should be emailed to THEMIS_Science_Support@ssl.berkeley.edu. Click 
the Close button to dismiss this widget. 
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6.10 TPLOT 

6.10.1 Import / Export  
 
The GUI maintains an internal representation of the data for its own use. Data loaded into the GUI directly use the 
thm_load_data routines available in the software distribution. Tplot variables created at the command line can be imported 
into the GUI for internal use, or exported from the GUI for command line use. The Load THEMIS Data and Manage Data 
Import/Export Tplot  items under the File pull down menu provide options to manage the data. See Sections 6.3.5 and 6.3.7 
for further details.  
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6.10.2 tplot_gui 
 
In addition to importing and exporting tplot variables the user can also plot variables from the command line for display 
within the GUI. Tplot_gui works in the same way that tplot works, however, tplot_gui will display the plot on a new page in 
the GUI graph area. Tplot  used in the original way will display the plot in a new window that is external to the GUI.  For 
example, at the IDL command line you can type the following: 
 
IDL>   tplot_gui, ‘tha_fgl_dsl’  
 
Before drawing the plot, the Verify Data panel will be opened. In order for the GUI to use tplot data it requires the variable 
be imported.  The Verify Data panel simply allows you to check the validity of the tplot meta data. See Section 6.3.7 for 
details on managing, importing, and exporting data. Figure 6.10.2a shows an example of the Verify Data window. 
 

 
 
Once you accept the meta-data values and click the OK button a new page and plot will be created. Figure 6.10.2b shows the 
new plot. 
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Because the default plot mode of the GUI is linear, spectral data will be drawn in linear mode. You can switch to spectral 
mode by using the Plot/Layout Options under the Graph pull down menu, or by clicking the graph icon button on the toolbar.   
 
No changes have been made to the tplot procedure and it functions as it always has.  An example of the IDL command line 
and resulting plot are show below in Figure 6.10.2c 
 
IDL> tplot, ‘tha_gfl_dsl’ 
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6.11 Platform Dependencies 

6.11.1 Linux 

6.11.2 Mac 


